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Module 1:
Introduction

Participant Information

As a user of the OCFS data warehouse, you will be responsible for interacting with various program and
system staff to implement and support desktop ad hoc reporting for your local district or agency. Your
responsibilities may include the following:

Working with agency or district staff to define data needs for ad hoc reporting;
Initiating and coordinating local efforts regarding data quality and data validation;
Implementing and utilizing the Cognos reporting tools — Impromptu and PowerPlay;

Generating predefined reports, modifying existing reports, and generating new reports from
the OCFS data warehouse;

Coordinating local efforts to schedule report generation;

Coordinating local efforts to distribute reports, including identifying appropriate personnel to
receive reports and physical distribution logistics;

Coordinating orientation and training of appropriate staff to generate reports and access the
OCFS data warehouse, where necessary;

Sharing results and issues with other report specialists across jurisdictions as part of a users’
group.

This guide provides basic step-by-step instructions for generating, modifying and creating reports from
the OCFS data warehouse.
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What is Cognos?

Cognos is the name of a software development company based in Canada. It is widely acknowledged to
be the leading provider of business intelligence applications. Business intelligence is the term given to a
category of applications and technologies for gathering, storing, sharing, analyzing, reporting and
providing access to data to help users make better decisions.

The Cognos suite of data query and analysis tools was selected to meet the specific reporting needs of
the local districts and voluntary agencies of the Office of Children and Family Services (OCFS). Cognos
was chosen because it provides flexibility and ease of use for non-technical users to generate, modify,
and create reports to support planning and operational needs. Cognos offers the same, or similar,
functions as the Microsoft Office suite of products, and so offers familiarity to computer users. It also
allows multiple users to access the same data source simultaneously. This allows flexibility for the local
districts and agencies to retrieve data when they need it. These user-friendly, flexible tools allow report
specialists to easily develop customized reports to meet the specific needs of their end users. Cognos
software runs on Citrix servers, requiring an extra login procedure and some preparation prior to
accessing the Data Warehouse.

Cognos
Impromptu / \ PowerPlay
Catalogs (*.cat) PowerCubes (*.mdc)
¥ ¥
Predefined User Reports {".imr) Predefined User Reports {".ppr)
What is the OCFS data warehouse?
The OCFS data warehouse is a collection of data retrieved from the
Connections and CCRS systems that users can access independently
of those production systems. The data from these two diverse
databases is organized and stored in the data warehouse. Data in the
OCFS Data Warehouse is available in a current point-in-time The OCFS data warehouse is
snapshot. Trend or historical views are also available. a “read-only” file, which

means that users who access
the data cannot change the
data. The data can only be
read. Users can query and
analyze the data using the

Cognos tools, but they cannot
change the data in any way.

The OCFS data warehouse is refreshed, or updated, on a weekly
basis. Thus, every Monday the data reflects the state of the
Connections and CCRS systems as of the previous week. Any
changes made in either production system during the week will not be
reflected in the data warehouse until the following week, after the
regularly scheduled update. A “Connections Data As Of Date” and a
“CCRS Data As Of Date” have been made available in the data

warehouse that reflect the dates of the last update so that users can
readily see the age of the data.
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The OCFS data warehouse has been organized into five separate data marts. These data marts are
subsets of the larger data warehouse. The data marts are focused on a particular subject, as shown
below:

o The Investigations and Allegations data marts contain

information on Child Protective Services; More information on the data
warehouse can be found in
the manuals located in the
Public Folders in Microsoft

Outlook. Instructions for
accessing the Public Folders
relating to the data
warehouse can be found in
this guide.

o The Foster and Adoptive Home (FAD) data mart contains
information pertinent to certification dates and
demographics of the individuals in the homes;

o The In Care data mart contains foster care and adoption
data on children who are in foster care, or have been
admitted or discharged from foster care; and

o The Legal data mart has all legal information associated
with each child in foster care.

The purpose of the data marts is to continue the structuring and organization of the data in ways that are
meaningful to users and to extract more efficiently data for analysis. The data marts are the data sources
for all catalogs that, in turn, are used for all cubes and predefined report creation.

The Content of This Guide

This step-by-step guide covers ad hoc reporting from the OCFS data warehouse using Cognos
PowerPlay. A separate step-by-step guide covers ad hoc reporting from the OCFS data warehouse using
Cognos Impromptu. It is expected that users will have basic computer skills, including Windows point-
and-click, navigation, scrolling, etc. Major objectives addressed include accessing, modifying, and
managing predefined PowerPlay and Impromptu reports, as well as creating new reports in Impromptu.
The material presented in the step-by-step guide is based on data in the OCFS data warehouse.
Overviews of the OCFS data warehouse and Cognos, as well as a discussion of where to go for
additional help, are also presented.

There are three appendices (Appendix A, B, and C) to this guide that contain more detailed information
about the various reports, cubes and catalogs that have been made available to you. These appendices
describe in more detail the New York State data you will be using. References to these appendices will be
made in the appropriate modules of the guide. A glossary of OCFS data warehouse and Cognos terms is
also a feature of this guide and can be found in Appendix C. Please refer to this glossary when you need
a more complete definition of any terms used in this guide.

The OCFS Training Database

It is not feasible to use the real OCFS Data Warehouse for training purposes, since that would breach
confidentiality standards. However, it is very beneficial for potential users to learn the Cognos tools using
data that is familiar to them. For this purpose, the OCFS Data Warehouse Team has designed a training
data warehouse that represents the same kind of data you will see in the real OCFS data warehouse.

The training database is available on a Citrix network server on the Z: Drive for you to practice your skills
and to try out new reporting techniques. You must login to Citrix to access the Training Database, just as
you would access the production Data Warehouse database. The Training Database can be accessed
with the Cognos User ID “train01” and the Password “train01”. The material presented in the OCFS Class
Manual is based on data in the OCFS Training Database.

Instructions for logging in to Citrix to access the Cognos tools are as follows:

P |
1 Double click the Internet Explorer icon on your desktop.
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Click the Favorites button on the Internet Explorer menu bar. (£l

Select “Data Warehouse Login” from the drop down-list and continue to step 10.

If “Data Warehouse Login” is not listed on the drop-down list, continue with step 5.

a ~h WO DN

In the Address line at the top of the Internet Explorer screen, type
http://OCEFSDATAWAREHOUSE.

| Address | hitp://OCFSDATAWAREHOUSE

;f'?"Gn:n

6 Click the Go button to the right of the Address box and wait for the page to load.

7 Click the Favorites button on the Internet Explorer menu bar and select Add to favorites from
the drop-down list.

8 Inthe Add Favorite dialog box, type “Data Warehouse Login” in the Name field.

Add Favorite .. .':.;- EJ I.l
“y Inbemet Explocer wall add thi la pour Favorbes ksl
e

[~ Make available offine Wjire g b | Carced I
MName: |Ela,aw'e|e}uuse Lagn Crazbe in > I

9 Click OK on the Add Favorite dialog box.

10 Enter your NT Username, Password, and Domain in the OCFS Data Warehouse login dialog
box.

OCFS Data Warehouse

Ummamaﬂ

Pmrdf

Domain [NYSDS5ALE

11 Click the Logon button at the bottom of the dialog box.

12 Click OK on the Confidential Warning screen.
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'mreng: This system and al data sccazsed thiough it ae confdential ard
'to the State of Hew Yok access is bmibsd bo suthorized
mulmmwramm

13 The OCFS Data Warehouse welcome screen is displayed. To the left of the screen are icons for
PowerPlay, Impromptu, Cognos Cubes, and Training Database.

Hhastart |

14 Double click either the PowerPlay or the Impromptu icon to launch the application.

If you wish to save any reports or files generated in the Citrix environment, you must save to the T: Drive.
In Citrix the T: Drive is automatically mapped for you. In order to access the T: Drive from your local
desktop, you must manually map to it. Since the location of the T: Drive can vary for different users, you
will be provided with the location of the T: Drive in Citrix (where it has already been mapped) that
corresponds to the login you are using. You must then map your PC to this location. This process must
be done once on each computer you will use to access Citrix.

Instructions for mapping your PC to the T: Drive are as follows:

1 In Citrix, press the Windows key on your keyboard to display the local desktop Start bar.

2 Click the Show Desktop button at the bottom of your PC to display your local desktop.

OCFS Data Warehouse Reporting Page 5
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Right click the My Computer icon on your desktop.

4 Select Map Network Drive... from the drop-down list.

5 In the Map Network Drive box, select the T: drive by clicking the drop-down arrow ﬂ to the right
of the Drive box. If the T: drive is already mapped elsewhere, leave the default selection in the
Drive: selection box.

Map Network Drive x|
Siindows can help you connect ko a shared network Folder

and assign a drive letter to the connection so that you can
\\ﬂ access the folder using My Computer,
]
et |

Specify the drive letter for the connection and the Folder
that ywou want ko conneck ko:

Drive: IT: j
Falder: I'l,'l,anchDalaav'l,sharengnj Browse. .. |

Example: Yiserverishare

V¥ Reconnect at logon

Connect using a different user name.
Create a shorkcut ko & Web Folder or FTP site,

< Back I Finish I Cancel |

6 In the Path or Folder field, enter the path to your T: Drive that has been provided for you (e.g.,
\\fnpcfsOalaavishare XX\userid).

7 Ensure that the Reconnect at Logon option in the middle of the Map Network Drive box is
selected.

8 Click Finish at the bottom of the Map Network Drive box.
9 Close the path directory widow by clicking the ‘X’ in the upper right corner of the box.

10 Close the My Computer window by clicking the ‘x’ in the upper right corner of the box.

Again, you only have to complete the above task one time. Once your PC is mapped to the T: Drive, you
will not have to map it again. If you move to another PC, you will have to repeat this process.

Cognos Common Logon

The Cognos Common Logon dialog box appears the first time you open any Cognos application
(Impromptu or PowerPlay). It requires you to enter a Cognos User ID and Password. When working in the
OCFS data warehouse, you will use the Cognos User ID and Password assigned to you by the OCFS
Data Warehouse Team. When working in the training database, you will use ‘train01’ for both the User ID
and Password. After inserting the appropriate User ID and Password and clicking the Log On button, a
key will be displayed in the lower right corner of your PC screen, signifying that you are logged into
Cognos. ™

It is not necessary to log off the Cognos Common Logon when you exit a Cognos application. You will be
automatically logged off when you exit the Citrix session. However, if you log on to the Training Database
using the ‘train01’ User ID and Password, you will remain logged on as such until you exit from Cognos
Common Logon and will only have access to training data. If you want to access your own “live” data, you
will need to exit Cognos Common Logon as “train01’ and log in with your own Cognos User ID and
Password.

1 Exit from any Cognos application that you may have open (Impromptu or PowerPlay).
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2 Right click on the key in the lower right corner of your PC. %

3 Select Log-Off from the drop-down list.

The next time you open a Cognos application (either Impromptu or PowerPlay), you will be prompted to
log into Cognos Common Logon. You can now enter your regular Cognos User ID and Password to
access your own “live” data.
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Module 2:
Getting Started in PowerPlay

What is Cognos PowerPlay?

PowerPlay is a data analysis tool that utilizes OLAP (On Line Analytical Processing) technology. Data is
presented in a summarized format but users have the ability to drill down into more detailed levels.
PowerPlay simplifies the process of spotting trends and anomalies and also provides reporting
capabilities.

In PowerPlay various views of the New York State Child Welfare system have been defined and
designated as “dimensions”. Dimensions are meant to answer the questions: Who?, What?, When?, and
Where?. For example:

e Who has been assigned to this CPS case or report?

o What are the specific allegations of the CPS report?

o When was this CPS report determined?

o Where does the child in this WMS/CCRS Services case reside?
Examples of dimensions in the OCFS data warehouse include:

o Statewide (State, Region, County, Unit)

e Date (Year, Quarter, Month)

e Allegation Type (Physical Abuse, Neglect, Emotional Maltreatment, etc.)

e Race (African-American, White, etc.).

Some dimensions are structured hierarchically. For example, the Statewide dimension’s highest level is
State; the next level would be Region, followed by County, Unit and Worker, respectively. The initial
presentation of the data in PowerPlay is at the highest or top level of the dimension. Users can then drill
down in to the successive levels of the dimension.

Various performance measures are included in the PowerPlay cube and can be viewed across the
different dimensions. Measures are the numerical indicators of performance. Examples of measures in
the OCFS data warehouse include number of CPS reports, child count, and number of allegations. Thus,
users can easily review number of reports investigated by worker over time to reveal trends of number of
children served, types of allegations, types of investigations, etc.

The files generated in PowerPlay that summarize specific measures by specific dimensions for specific
areas of interest are called “cubes”. The files are considered multidimensional because the data is
summarized by more than one category, or dimension, all of which can be viewed at the same time rather
than one at a time. Thus, the term “cube”, which suggests depth, as well as height and width, or
multidimensionality.

The OCFS data warehouse project team has created the following PowerPlay cubes:

e CPS - Investigations Cube e CCRS - Discharge from Foster Care

Summary Cube
e CPS - Allegations Cube

e CCRS - Admission to Foster Care
e CCRS —In Care Summary Cube Summary Cube
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There are separate cubes for each of the last five years for Investigations and Allegations, and current
year-to-date, plus an “All Years” cube that provides summary information only to the county level and is
accessible by local districts and voluntary agencies. More detailed descriptions of the cubes available for

your use can be found in Appendix A.

Accessing PowerPlay

Cognos software runs on a Citrix server. Mapping your PC to the T: Drive and logging into the server are
the only steps necessary to begin. Once you have successfully logged into Citrix, you can open the

PowerPlay application.
1 Double click the Internet Explorer icon on your desktop.

2 Click Favorites on the browser menu bar and select “Data
Warehouse Login “ from the drop-down list.

Note: If “Data Warehouse Login” does not appear on the
Favorites list, do the following:

e Type the following in the Address line:
“http://OCFSDATAWAREHOUSE”"

o Click the Go button and wait for the Login page to load.
¢ Click the Favorites toolbar button.

o Select “Add to Favorites” from the drop-down list.

o Type “Data Warehouse Login” in the “Name:” field.

e Click OK.

If you are logged into Citrix

for 15 minutes without any

activity, you will be logged

out and work you have not
saved will be lost. Any

keystroke or movement of the
mouse will reset the 15-
minute timer.

Enter your NT User ID, Password and Domain in the Data Warehouse Login dialog box.

Click Logon.
Click OK on the Confidential Warning Screen.

6 Double click the PowerPlay Icon to launch the application.g

7 A Welcome box will display on your screen. You can choose to start your PowerPlay sessions
with this Welcome dialog box or not. If you choose not to use this option, deselect it by clicking in

the box to the left of “Show this dialog at startup”.

8 Click the Close button at the bottom of the Welcome dialog box.
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Accessing Remote Cube Connections

Since all of the cubes you will be using in PowerPlay are located on the Data Warehouse Server, you will
be accessing these cubes as “remote” cubes; “remote” simply meaning that they are not located on your
local drive. Instructions for this procedure are located in the Public Folders on Microsoft Outlook. The
instructions have also been included here for your convenience:

1 Click File on the menu bar at the top of the PowerPlay screen and click Open from the drop-
down list. (File > Open).

2 Inthe Choose a Report window, open the Files of type box by clicking the down arrow to the
right of the box. Select PowerPlay Cubes (*.mdc) from the selection list.

Choose a Report H
Loak jr: |rj D atavw arehouse _VJ & |‘_"F v Open I
[Cubes: Cancel |
Manuals
Pre-defined User Reparts Explain |
B Report Catalogs
CAReport Library [ eSS
ol e |
€ Hemote
File name: l ™ Prompt for Cube
Files of type: IPowerPIay Feports [*.ppr, *.pps] _:I
Description:

2

3 Inthe Access section of the Choose a Report window, select Remote by clicking the radio
button to the left of it.

4 In the Choose a Remote Cube dialog box, click the drop-down arrow ﬂ to the right of the
Connection window.

Sarvei oy |FoeveFly Endeens Saen j
[ azorplan

5 Select Datawarehouse from the drop-down list.
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Choose a Remote Cube (2]

Connect I <5elect 3 connection> ﬂ Connectiors I Open I

nnection:
Cancesl |
Explain |

Aocess——————
 Local
& Remote

Server type: PowerPlay Enterprise Server j

Description;

6 The Choose a Remote Cube window now displays a list of cubes.

Choose a Remote Cube H

Connect [{BEE= e Connections. . | Dpen

Admiszions_to_Foster_Care_Summary -
Allegations 1938

Allegations 1939 Explain
Allegations 2000
Allegations 2001 Access
Allegations 2002 " Local
Allegations 2003

Dizcharges_From_Foster_Care_Summary

Great Outdoors

In_Care_Summary ﬂ

Cancel

& Remote

Server lwpe: PowerPlay Enterprize Server Li

Drescription;

7 Select a cube and click Open.

The Cognos Common Logon window will appear. Cognos Common Logon maintains your security
authentication data so that you can open multiple secure data sources using different Cognos
products. This means you only have to provide a User ID and Password once, even when you
navigate from one Cognos application to another (PowerPlay and Impromptu). So, if you enter your
User ID and Password into PowerPlay, then open Impromptu, you will not be prompted to enter it
again. Enter your Cognos User ID and Password in the boxes provided, and then click on the Log
On button. A key will appear in the right corner of your PC, signifying that you are logged into the
Cognos Common Logon server.

Enler & user ID and password that is walid for Cognos products,

Lises ID;

Log On Cancel
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Module 3:
Using Predefined and Default PowerPlay Reports

Several standard Allegations and Investigation reports have already been created for you from the
PowerPlay cubes defined. The Management Reporting Workgroup defined these reports as reports that
would be helpful at both a management and supervisor/worker level. As noted previously, these reports
will display only the data that is applicable to you; i.e., for your local district or agency. These reports are
available to you in the Data Warehouse folders on the Data Warehouse Network Server X: Drive as
illustrated below.

Desktop
OCFS Datawarehouse
DataWarehouse
Pre-defined User Reports
Descriptions of these reports and the data contained in them can be found in Appendix B.

In addition to the official pre-defined user reports, users can access summarized information by opening a
cube directly and reviewing a PowerPlay default report. Default reports display the highest-level summary
of the first two dimensions in the cube as the rows and columns and the first measure of the cube as the
values in the cells. All of the features available in a pre-defined report are also available in the default
reports. Default reports are available to you by opening PowerPlay cubes on the Data Warehouse Server
X: Drive, as illustrated below:

Desktop
OCFS Datawarehouse
DataWarehouse
Cubes

Opening Predefined Reports

Once you have reviewed the available report descriptions and have determined which ones you will need
to see on a regular basis, you can open the report from the Data Warehouse folder on the Data
Warehouse Network Server. Assuming you have opened the PowerPlay application on your PC, follow
the directions below to open a predefined report:

1 Click the File menu option on the top left of the PowerPlay screen.
2 Select Open from the drop-down list.

3 Inthe Choose a Report dialog box, click the Prompt for Cube box on the right side.
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Chuuse a Repuil H

Look jr: | _ Investigatons |‘=_’F Open |
=1l eport Determinations Dunng the F=no de | akels.pp Cancel
: " . ; )
= | HM LPS Stagss ard Heaorts Lurrent Status statewade ppr Explain
o
i
File narme: |THN CF5 Report Deterninatons During the Per ¥ Prempt for Cube
Files of bype: |PoNerF'ay Reports [*.ppr., * ppx] j
Description:

4 Open the Look in directory box by clicking the arrow ﬂ to the right of the box. Navigate as
follows:

Desktop
OCFS Datawarehouse
DataWarehouse
Pre-defined User Reports
Any folder ending in “PowerPlay”
Select any report from the list by clicking on it once to highlight it.
Click the Open button on the right side of the box.

The Choose a Remote Cube dialog box displays. Open the Connections drop-down list by
clicking the arrow to the right'| of the Connect box.

8 Select Datawarehouse from the listing.

Choose a Remote Cube H

Connections... | Open

@ Allegations 1938
Allegations 1933 E=plain
Allegations 2000

Allegations 2001 Access
Allegations 2002 " Local
Allegations 2003 & Remate
Dizcharges_From_Foster_CareSummary S

Great Outdoors

Cancel |

. In_Care_Suramary j
Server lype: !PowerPIay Enterprize Server ;i
Description:

S

9 Select a cube from the listing:

o For the Allegations reports, select the YEAR that you want to run the report for (e.g.,
Allegations_2002 for calendar year 2002 data)

o For the Investigations reports, select the YEAR that you want to run the report for (e.g.,
Investigations_2001 for calendar year 2001data)
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10 Click the Open button in the upper right corner of the screen.

11 The Cognos Common Logon box will display. Enter your Cognos User ID and Password and
click the Logon button. The report you selected will display on the screen.

Opening PowerPlay Default Reports

As mentioned previously, users can access a default PowerPlay report by opening the cube directly
rather than by opening a pre-defined report. Default reports are retrieved by completing the following
steps:

3

1 Select File > New on the menu bar OR click the New button on the toolbar. “—

2 Inthe Choose a Local Cube dialog box, click the Remote option in the Access section.

3 Inthe Choose a Remote Cube dialog box, open the connections listing by clicking the arrow
ﬂ to the right of the Connect window.

4 Select Datawarehouse from the connections listing.

Choose a Remote Cube H

Connect I e LTS Cornections... | DOpen

M llegations 1933

@ 2llegations 1999 Explain
® 2legations 2000

. Allegations 2001 Access

W Alegations 2002 " Local
@ Allegations 2003 o
. Dizcharges_From_Foster_Care_Summary Sl

Great Outdoors

Cancel |

. In_Care_Surnmary j
Server lype: !PowerPIay Enterprize Server Li
Dezcription:

N

5 Select a cube from the Data Warehouse listing.

6 Click Open on the Choose a Remote Cube dialog box.

Components of the PowerPlay Screen

Menu Bar

There are several components of the PowerPlay report screen that you should become familiar with in
order to effectively navigate and modify the report. At the top of the screen is a menu bar with the
standard options available in most Microsoft-type applications (i.e., File, Edit, etc.). There are several
other options specific to the PowerPlay application, such as Explore and Calculate, which we will explain
more fully as we explore predefined reports.

Ej File Edit Yiew Insert Explore Calculste Format Tools ‘Window Help

Toolbar
Beneath the menu bar is a toolbar that provides quicker access to the available options. These toolbar
buttons are briefly explained below:
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[1 New — Starts a new report. §2  Explorer <> Reporter — Switches from
Explorer to Reporter mode and vice versa.
E Open — Opens an existing report. |@ Crosstab — Displays report in crosstab
report format.
E Save — Saves the displayed report. & Pie Chart — Displays report as a pie chart.

§| Print — Will print the displayed report. It is ﬂ 3-D Bar — Displays report data in 3-D Bar
not recommended that reports be printed chart format.
directly from PowerPlay.

[&] Print Preview — Displays the current report | ¥ Simple Bar Chart — Displays report data in
as it will appear on the printed page. It is not bar chart format.
recommended that reports be printed
directly from PowerPlay.

Undo — Clears the most recent action. la| Clustered Bar Chart — Displays report data
in clustered-bar chart format.

5

Reset Dimensions — Returns the displayed |[4a] Stacked Bar Chart — Displays report data in

X

J report back to top-level summaries. stacked-bar chart format.

ﬂ Dimension Viewer — Displays the Dimension |£| Single Line Chart — Displays report data in
Viewer panel on the left side of the screen. single-line chart format.

Drill Through — Drills through to an Q Multi-Line Chart — Displays report data in
Impromptu detail report. multi-line-chart format.

Swap — Swaps rows and columns in the
report.

Scatter diagram — Displays report data in
scatter diagram format.

= B

Sort — Sorts selected column in ascending !i Correlation Chart — Displays report data in
order. correlation chart format.

Rank — Ranks selected column and assigns
a rank order number.

L

Dimension Line

The report itself has several components that need to be further explained. Across the top of the report is
a series of folder-shaped buttons with descriptions on them. This is the dimension line and shows you
what dimensions are available in the cube and what levels of each dimension are being displayed on the
report. If you click on any of these dimension folders, the values of each of the highest-level categories of
that dimension will be displayed in a dimension menu. We will be using the dimension line when we
modify reports. Please refer to Appendix A of this guide to review detailed descriptions of each of the
cubes and the dimensions and measures they contain.

| El Statesnide I Drate: I mCANDS Reporter Description | Eu:unneu:tiu:uns Data As Of Date | mEASURES

Layers
Pre-defined user reports have an additional feature not found in default reports. Beneath the title of the
report and above the body of the report is a line that has the text “Layer __ of __ “ at the right end, plus

up and down scroll arrows. == This is the /ayer line of the report. Layer is the name used by PowerPlay
for a third dimension added to a report. Most pre-defined reports have been “layered” by location. You will
see only the layer applicable to the county or agency you represent. The last layer represents the total, or
top level, of the layer. Scrolling up and down the layer by using the scroll arrows will bring you to each
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unit of the county. The report body changes with each change you make in the layer to reflect the data
applicable to the selected layer.

Laver10of10 j

Getting Around in PowerPlay Reports

Scrolling

Most predefined PowerPlay reports cannot be fully displayed on a single screen. To view the report in its
entirety, you will need to scroll up, down, left and right. The vertical scrollbar is located at the far right of
the screen. The horizontal scrollbar is located at the bottom of the screen. There is also a set of “Next

Page” buttons ==l at the top and/or bottom of the vertical scrollbar and at the far right and/or left of the
horizontal scrollbar. Clicking these will advance you to the next page of the report.

Adding the Latest “As Of” Date

The latest “as of” date for the PowerPlay reports changes every time the data warehouse is refreshed.
This date is important since it tells us the last date for which the data on the report is valid. An “as of” date
of 8/2/2001 indicates that the report reflects the state of the data as of midnight on August 2, 2001. It is
important, therefore, that this date appear on the report so that users know the age of the data. The “as
of” date is part of the title block of all pre-defined user reports. The date is not part of the default
PowerPlay reports. To add the latest “as of’ date to a predefined user report:

1 Click on the dimension folder titled “Connections Data As Of Date”.
2 In the drop-down list, select the latest date (there should only be one).

3 The latest data warehouse refresh date should now appear in the title of the report.

£ | Statewide | | Date | mCANDS Reporter Description | | Connections Data &3 OF Date | mE.ﬂ.SUHES ||

Changing Layers

As mentioned previously, layers represent a third dimension added to a PowerPlay report. The Statewide
dimension has been used as a layer in most of the predefined PowerPlay reports. The default in
PowerPlay is to display the highest, or summary, layer. Thus, you would be looking at the state level of
any PowerPlay report you open. To view the sub-level reports, you need to scroll through the layers by
using the up and down scrollbar arrows at the far right of the layer line, as follows:

1 Click on the up arrow =_ at the right of the Layer line that includes the text
‘Layer __of _~

2 The report now displayed is for a sub-level within the state.

3 Continue clicking up until the text on the layer line reads “Layer 1 of __”. There are no more
layers after this.
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Drilling Down to Lower Levels of Detail

The default in PowerPlay reports is to display summarized data at the
highest level of the appropriate dimensions. You may want to see
what makes up these summarized numbers. You can “drill down” to
lower levels of detail by simply double clicking on a data field. Your
cursor will tell you whether or not you can drill down on a
particular data field. It turns into a plus sign if the field has I::::]
lower levels of detail. When you reach the lowest level of detail, there
will be a carat (*) inside the plus sign, indicating that you can only drill

up from there.

1 Place your cursor over any data field in the report. If your

Note:

When you drill down to lower
levels of detail, you effectively
filter your report. In other
words, you will now see only
the details of the category on
which you drilled down. You
will no longer see the other
categories.

cursor appears as a plus sign on the screen, then you can drill down on the data.

Double click on the data field where your cursor displays as a plus sign.

The report now changes to display the next level of detail in the hierarchy of the dimension you
selected. If you clicked on a county, you should now see the units of that county. If you double

click on a unit, the report will display the workers in that unit.

4 To drill back up, move your cursor to the summary row or
column of the report. Your cursor should now appear as a
plus sign with a carat in the middle. This means that you can
only drill up from here. Double click on the report when your
cursor displays as a plus sign with a carat (*) in the center.

5 There is a toolbar option called Reset Dimensions M that
will reset all of the dimensions in your report back to the
highest levels. It will also remove any filters you may have
inadvertently placed in the report.

Drilling Through to Other Cubes

Note:

Not all data fields have lower
levels of detail. You could
double click on a data field
and the report will display just
that data field. You did not
make a mistake; you simply
drilled down on what was
already the lowest level.

You can also drill through to other available PowerPlay cubes. For example, if you are exploring
Investigations data in the 2001 cube and decide that you need to see data for the previous year (i.e.,

2000), you can drill through from the 2001 cube to the 2000 cube.
1 Place your cursor over any data field in the report.

2 Click the Drill-Through button on the toolbar.

3 A Drill-Through dialog box appears listing all of
the other PowerPlay cubes available to you.

4 Select a cube from the listing and click the OK
button at the bottom of the dialog box.

5 Your report now shows just the data you
selected on your original PowerPlay report with

Dl Thrawigh EE
[hestiration [hes criphion
1 B Ol rveeestigations_ 1998
BN O rreestagastionss_ 1393
SN0 rresbgatiors_2000
SO rwestgationn_ A Yeas
Eropeitie:

Tup  PowerPlay cubs

Mame:  PPDSRamobeConncord : BN e
File: Irreestigations_ 1398 mdic

Lacshan viCoannced]\CognoscubeshD alaisr

Scope:  Cube
the data from the new cube.
6 Toreturnt iginal rt, click File > - D l =
o return to your original report, click File
Close on the menu bar. ] _ owed |
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7 Click No to the “Do you want to save your changes” message.

Drilling Through to Impromptu Reports

As discussed previously, PowerPlay cubes contain summary information. You can find the number of
children discharged, for instance, but you cannot retrieve the names of these children in PowerPlay.
However, for the summarized CCRS data contained in the Admissions, Discharges and In Care, cubes, a
feature has been added to enable users to retrieve more detailed information in an Impromptu report.
This feature is also called Drill-Through and can be accessed using the Drill-Through button from a
default report using any of the above-mentioned cubes. It must be cautioned, however, that you should
never drill-through to Impromptu from the high-level summary default report. You should first drill down to
an appropriate lower level of detail (i.e., drill down to a specific year and a specific district or agency).
System resources required to retrieve records for all children placed in care over the past five years for
the entire state may slow processing time considerably. So, you should always drill down before you drill
through.

1 In PowerPlay, click the New button g on the toolbar or select File > New on the menu bar.

2 In the Choose a Local/Remote Cube, make sure Remote is selected in the Access section.

Open the connections listing by clicking the arrow ﬂ to the right of the Connect window.
Select Datawarehouse from the connections listing.
Select one of the following cubes from the Data Warehouse listing:

o Admissions to Foster Care Summary

e Discharge from Foster Care Summary

e In Care Summary

6 On the default report, drill down to your specific district or agency and drill down to a specific
year, quarter, or month.

7 Click on the cell value for which you need more detailed information.

8 Click the Drill-Through button on the toolbar.

1290 1999 2000 200

9 Impromptu opens on your screen. A message box appears advising that the report you
requested is read-only. Click OK.
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10 The detailed report appears. You can scroll up and down and from page to page. Please refer to
the Impromptu Step-by-Step Guide for more information about saving, printing and converting
Impromptu reports.

Coumay Office Thnit ke CIN Child Name Case ID Case Hamne (Cander| Race
HITD 201 Oiffice : DAP Uit : PIH [Worker : 840 |IT3S670E  |ALETON ANTHONY E E04103 ALETON CECILLA Dfale  [White
Cifice : EKOP (Uit : 144 [Worker : 633 |[HET4230 |COVERDALE ASHLEY Efd435 COVERDALE DEEEIE Feruale [White
TWH?541T [PETERS TANA M Edf4408 FLET CHEF. REEECCA [Ferruale [Elack or Afcan fem
Worker : 620 (WVTA338 T [MITCHELL ATLAHTA E674303 LT CHELL PEMELOPE Tlale  [White
Cifice : UME Uit : 005 [Worker : 804 |PMDO524D [PETERS JOZEPH 2 E04130 PETERS CHEISTIMA Bdale  [Crlawm
Ukt : 007 [WWorker ; 806 |PEE26S60 |GRIMEEY CHAD E B624215 FRIMEEY JOSEPH W Bdale  [White
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Viewing Reports as Charts

The default in PowerPlay is to display report data in a crosstab report, but you have the option to view
your report visually in any one of nine different chart types. Clicking the appropriate button on the toolbar
can do this. The different chart types are briefly described below:

® pie Charts show the relationship between the whole and its parts. For example, of all
determinations during the year, what percentage and/or number were indicated versus
unfounded?

ﬂ 3-D Bar Charts will show the relationship between two or more variables. This chart is ideal
for showing large amounts of data. For example, for all reports received during the year, how
many were reported by mandated versus non-mandated reporters?

at Simple Bar Charts will show changes over time or contrasts two or more variables. This
format is ideal for showing trends and anomalies in the data. For example, for all reports
determined during the year, how many were determined within 30 days, between 31 and 60 days,
between 61 and 90 days, over 90 days?

M| Clustered Bar Charts group and summarize related categories to make it easier to compare
summaries. For example, data for two or more years can be displayed in a clustered format to
compare days to determination over time.

|l#2] stacked Bar Charts show relative proportions of parts to the whole and the relationship
between the parts. For example, the days to determination data can be segmented into indicated
and unfounded determinations as stacked bars.

E| Single Line Charts will show change over time or contrasts between two or more variables
to reveal trends and irregularities. For example, total CPS Reports received can be graphed over
several years to track the trend in reporting.

Q Multiline Charts show trends and relationships between variables. It can also be used to
display time series analysis. For example, total indications for several years could be added to
the total reports received over several years to view the trend in relationship between reports and
indications.

Lz Scatter Charts are used to compare two different measures. You must have at least two
measures to use the scatter chart. One application might plot the actual days to determination by
month of determination to investigate any relationship in timing.

!i Correlation Charts are also used to compare the values of at least two different measures.
Two or more interval measures, such as days in investigative stage and days overdue may be
plotted to review strength of correlation between the two measures.
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After reviewing the types of charts available to you, change your report to a chart:
1 Click the Pie Chart button on the toolbar.

2 Note that the Layer line still displays at the top of the report. You can change layers in the pie
chart by clicking the up and down arrows on the layer scrollbar. The pie chart will change
accordingly.

3 Note the legend on the right side of the pie chart. Click on any piece of the pie chart and the
appropriate title for that piece is automatically highlighted in the legend. The selected piece is
also removed from the rest of the pie chart.

4 To return to the crosstab report, click on the Crosstab button on the toolbar. Iﬁ

Closing Reports and Exiting PowerPlay
1 Select File > Close on the menu bar.
2 You will get a message asking if you want to save changes to the report. Click No.

3 Click the ‘X’ in the upper right corner of the screen.

If you wish to exit from Citrix, perform the following additional steps:
1 Click the Start button in the lower left corner of the screen.
2 Select “Log out****” from the pop-up menu.
3 Click Yes at prompt.

4 Click the “x” in the upper right corner of the Internet Explorer window to return to your local
desktop.

Saving modified reports is covered in Module 6 of this guide. Please refer to it if you have made changes
to a predefined report and wish to save it under a different file name.
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Module 4:
Modifying Predefined and Default PowerPlay Reports

In some cases, you may need to modify a predefined PowerPlay report to better meet your needs, or to
meet new needs. This module covers all of the skills you will need to make necessary changes. However,
please take note that you cannot save any changes to the original PowerPlay report. All changes must be
saved as a new report name to your T: Drive. You may refer to Module 6 of this guide to review
instructions on saving your modified PowerPlay reports.

You can also create your own PowerPlay reports by opening a cube, rather than a predefined report, and
making the same modifications discussed in this module to a PowerPlay default report. When you open a
cube in PowerPlay, a default report listing the first two dimensions and the first measure is displayed. You
can then change rows, change columns, change measures, add layers, nest categories, and make all of
the modifications discussed here.

Dimension Viewer

ﬂTo make report changes easier for users, PowerPlay provides a tool called the Dimension Viewer.
This tool displays a panel to the left of the PowerPlay report that lists all of the various dimensions in a
Windows Explorer folder layout. To view the various levels of each dimension, double click the plus sign
[+] to the left of the folder you wish to open. Another toolbar becomes available to you on the left side of
the screen. These toolbar buttons simplify the process of modifying reports. The buttons are briefly
described below:

= Replace Rows — Replaces existing report rows with dimension selected.

ml Replace Columns — Replaces existing report columns with dimension selected.
@ Replace Layers — Replaces existing report layers with dimension selected.

?I Filter — Filters report by category selected.

Changing Rows/Columns

You can change the rows and/or columns in the report by using the vertical toolbar options available in
the Dimension Viewer. Another option is to use the Dimension Line and click and drag new dimensions
from there to your report.

Changing Rows using the Dimension Viewer
1 Login to PowerPlay and open a predefined user report or a default report.
2 Click the Dimension Viewer button on the toolbar. ﬂ

3 In the Dimension Viewer, select a dimension that does not currently appear on the report. Click
on the dimension once to highlight it.

K
4 Click the Replace Rows button on the side toolbar. élThe report now shows your selected
dimension as rows rather than the original row dimension.

Changing Rows using the Dimension Line
1 Login to PowerPlay and open a default report or a predefined user report.

2 Select a dimension that does not currently appear in the report on the Dimension Line.
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3 Holding your left mouse button down, drag the dimension into the row area of your report. The
row area is the first column, or row title column, of the report.

4 Release the left mouse button. The report now shows your selected dimension as rows rather
than the original row dimension.

Changing Columns using the Dimension Viewer
1 Login to PowerPlay and open a predefined user report or a default report.

Click the Dimension Viewer button on the toolbar. ﬂ

In the Dimension Viewer, select a dimension that does not already appear on your report. Click
on the dimension once to highlight it.

T
4 Click the Replace Columns button M on the vertical toolbar. The report now shows your
selected dimension as columns rather than the original column dimension.

Changing Columns using the Dimension Line
1 Login to PowerPlay and open a predefined user report or a default report.

2 Select a dimension that does not currently appear in the report on the Dimension Line.

3 Holding your left mouse button down, drag the dimension to the column area of the report. The
column area is the column title row of the report.

4 Release the left mouse button. The report now shows your selected dimension as columns rather
than the original column dimension.
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Nesting is a method of bringing another category into your report to provide additional information and
increase your perspective of the data. You can add a lower level of detail from the same dimension, such
as adding the Region level to the Statewide level. Or you can bring in another dimension as a nested row
or column. Nested categories will appear beside each other in rows or above or below each other in the
columns. Nesting is an effective method of exploring data from the top level of a dimension all the way
down to the bottom level. Adding nested categories can reveal critical information about the Connections
system on a single page. The data will continue to display across and down the screen. As a result, you
may need to use the vertical and horizontal scroll bars, as well as the Next Page buttons, to see all of the
data.

Nesting Rows using Another Dimension
1 Login to PowerPlay and open a predefined user report or a default report.

2 Select a dimension that does not currently appear on your report on the Dimension Line.

3 Holding your left mouse button down, drag the dimension to the row area of the report. Your

cursor changes to

4 When a bold black line appears between the row title column and the first column of the report,
release your left mouse button. Your new dimension is now “nested” within the original row
dimension.

Nesting Rows using a Lower Level of the Same Dimension
1 Login to PowerPlay and open a predefined user report or a default report.

2 Click the Dimension Viewer button on the toolbar.

3 In the Dimension Viewer, open the dimension currently appearing as rows in the report by clicking
the plus sign [+ to the left of the folder.
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4 Select a lower level from the drop-down list by clicking on it once to highlight it.

Holding your left mouse button down, drag the lower-level dimension to the row area of the
report.

6 When a bold black line appears between the row title column and the first column of the report,
release your left mouse button. The report now shows a lower level of the same dimension
“nested” within the original row dimension.

Nesting Columns using Another Dimension
1 Login to PowerPlay and open a predefined user report or a default report.

2 Select a dimension that does not currently appear on your report on the Dimension Line.

3 Holding your left mouse button down, drag the dimension to the column area of the report. Your

cursor changes to %3 :

4 When a bold black line === appears between the column title row and the first row of the
report, release your left mouse button. Your new dimension is now “nested” within the original
column dimension.

Nesting Columns using a Lower Level of the Same Dimension
1 Login to PowerPlay and open a predefined user report or a default report.

2 Click the Dimension Viewer button on the toolbar.

3 In the Dimension Viewer, open the dimension currently appearing as columns in the report by
clicking the plus sign [ to the right of the folder.

4 Select a lower level from the drop-down list by clicking on it once to highlight it.

Holding your left mouse button down, drag the lower-level dimension to the column area of the
report.

6 When a bold black line appears I between the column title row and the first row of the report,
release your left mouse button. The report now shows a lower level of the same dimension
“nested” within the original column dimension.

Deleting Nested Columns and Rows

1 Assuming you are currently logged into a report with nested rows or columns, click on the nested
level of the report. All nested rows or columns will be highlighted.

2 On the menu bar, select Edit.

Select Delete from the drop-down list. Edit 2> Delete > Level

Select Level from the drop-down list.
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Changing Layers

Layers in a PowerPlay report represent a third dimension that has been added to the report. Several of
the predefined PowerPlay user reports have been designed with location layers. Scrolling through the
layers changes the body of the report to represent the region, county, or unit that has been selected in the
layer line. You may wish to change the layered dimension to reflect another aspect of the organization,
such as time. There is a layer button on the Dimension Line (to the far left of the dimension line) and a
Change Layers button in the Dimension Viewer to help you accomplish this.

Adding Layers to Reports
1 Login to PowerPlay and open a predefined user report or a default report.

2 Delete the existing layer by clicking on the layer line once to highlight it. Hit the Delete key on
your keyboard.

Select a dimension on the Dimension Line.

4 Holding your left mouse button down, drag the dimension to the far left of the Dimension Line and

place it over the Layers button. =

5 Release your left mouse button. Your selected dimension will now appear as a Layer Line
beneath the title of the report.

Changing Layers using the Dimension Viewer
1 Login to PowerPlay and open a predefined user report or a default report.

2 Click the Dimension Viewer button on the toolbar.

3 In the Dimension Viewer, select a dimension that does not currently appear on the report by
clicking on it once to highlight it.

4 Click the Replace Layers button on the vertical toolbar. @ The new dimension now appears in
the Layer Line beneath the title of the report.

Changing Layers using the Dimension Line
1 Login to PowerPlay and open a predefined report or a default report.

2 Onthe Dimension Line, select a dimension that does not appear on the report.
3 Holding your left mouse button down, drag the dimension to the Layer Line on the report.

4 Release the left mouse button. The new dimension now appears in the Layer Line of the report.

Deleting Layers from a Report

1 Assuming you have logged into PowerPlay and have opened a predefined user report with layers
in it; highlight the Layer Line by clicking on it once in your report.

2 Press the Delete key on your keyboard; OR
3 Select Edit > Delete - All Layers on the menu bar.
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Filtering Reports

Filtering allows you to customize a predefined report by focusing the data on the exact level of information
you want in each dimension. For example, you may only want to see CPS report information for Indicated
reports. You can filter the report on either the Dimension Line or the Dimension Viewer.

Filtering a Report using the Dimension Line
1 Login to PowerPlay and open a predefined user report or a default report.

2 On the Dimension Line, select the dimension you will use as a filter by clicking on it once.

3 Select the specific category you want to use by successively drilling down in the dimension folder
until you reach the category you want.
For example:

e Open the NCANDS Reporter Desc folder on the Dimension Line.
e Select Mandated from the next drop-down list.

The body of the report has changed to reveal data that applies only to CPS Reports reported by
individuals mandated by law to report incidents of child abuse/neglect. On the Dimension Line, the
NCANDS Reporter Desc folder now reads “Mandated.”

Filtering a Report using the Dimension Viewer
1 Login to PowerPlay and open a predefined user report or a default report.

2 Click the Dimension Viewer button on the toolbar. ﬂ

3 Inthe Dimension Viewer, open the folder for the dimension you want to use as a filter by clicking
the plus sign [+ to the left of it.

4 Continue expanding successive folders until you reach the specific category you want to use as a
filter.

5 When you have reached the specific category of the dimension, click on it once to highlight it.

6 Click the Filter button on the vertical toolbar. ?I

The body of the report has changed to reveal data that applies only to the filter category you have
chosen.

Removing Filters
You can remove filters by drilling back up to the highest level of the dimension on the Dimension Line or

by clicking the Reset Dimensions button on the toolbar. M
1 Login to PowerPlay and open a predefined user report or a default report.
2 Place afilter on the report using either the Dimension Viewer or the Dimension Line.

3 Remove the filter on the Dimension Line by clicking the dimension you used for a filter and
selecting the highest level from the drop-down list again; OR

4 Remove all filters by selecting the Reset Dimensions button Q on the toolbar.
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Changing Measures

As mentioned previously, measures are numeric indicators of performance. The measure in the current
report will be displayed in the dimension line as the text in the last folder. Some reports include many
different measures as columns or rows, in which case the word MEASURES will appear on the last folder,
indicating that more than one measure is being displayed in the report. You can change the measure
displayed in the report on the Dimension Line.

To Change a Single Measure in a Predefined Report
1 Login to PowerPlay and open a predefined report or a default report.

2 Onthe Dimension Line, click the Measures folder (the last folder).

3 Select MEASURES from the drop-down list.
MEASLURES

Iriskes Currerdly Not Frogressed
Iakes Currently Mot Progressed - Avg. Days

CFS Reparts Cloeed During Pariod

CPS Reports Clozed During the: Period - Avg. Davs

v, Siages Currently Open

iy Siages Currently Ackive - Awvg, Days

Cernpleba, bt Currently Submitted far Appreval
Compleba, Mol Curranlly Submibed far Approval - Avg. Day's
Subamittad Tor Approsal, Mot Agaproesd

CFS Reports Currenty Crvercus:

CFS Reparis Currently Crverdue - Avg, Deys

Open CFS Reparts Mot Curmently Owerdus

-

4 Click the MEASURES folder again.
Select the measure you want to see from the drop-down list.

The new measure you just selected will now display in the report and will be shown on the
MEASURES folder at the end of the Dimension Line.

To Add All Measures As Rows or Columns Using the Dimension Viewer
1 Login to PowerPlay and open a predefined report or a default report.

2 Click the Dimension Viewer button on the toolbar.
3 Inthe Dimension Viewer, highlight MEASURES by clicking on it once to select it.

4 Click the Replace Rows or Replace Columns button on the vertical toolbar.

To Add All Measures as Rows or Columns Using the Dimension Line
1 Login to PowerPlay and open a predefined report or a default report.

2 On the Dimension Line, make sure the word MEASURES appears on the Measures folder (last
folder on the line). If not, click the folder and select MEASURES from the drop-down list.

3 Place your cursor on the Measures folder, hold your moue button down and drag the folder to the
columns or rows area of the report.

4 Release your moue button and all of the measures will be displayed on the report as either
columns or rows.
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Deleting Measures

When multiple measures (or all measures) have been selected as either columns or rows in a report,
PowerPlay gives you the option of selectively deleting some of them. For instance, you have selected all
measures available in Investigations, but do not want to see the ‘Avg. Days’ measures. You can delete
those columns/rows you do not want to see.

1 Login to PowerPlay and open a predefined user report or a default report.

2 Using one of the methods described above, select all measures as columns or rows on your
report.

3 Highlight those columns or rows you want to exclude by placing your cursor at the top of the
column or row and clicking once. Note: Use the Ctrl key or Shift key on your keyboard to
select more than one column at a time.

4 Press the Delete key on your keyboard.

Ordering Data

To enable you to better review your report data, you may need to sort it in a certain order. Sorting
arranges categories in ascending or descending order. You can use the Sort command to arrange a row,
column or layer in alphabetical or numerical order. There should be a Sort button on the PowerPlay
toolbar that will automatically sort the data in ascending order. If there is not, you can add the Sort button
using the Tools menu, as follows:

1 On the menu bar, select Tools > Customize Toolbars.

2 Open the Categories selection box by clicking the down arrow | to the right of the Categories
box.

3 Select the Explore option, and then select the Sort button. ﬂl

4 Click the Close button in the upper right side of the box.
Sort in Ascending Order Using the Sort Button
1 Login to PowerPlay and open a predefined user report or a

default report. The Sort button allows an

ascending sort only.
2 Select the column you want to sort your report by placing

your cursor in the column header and clicking once to PowerPlay does offer more
highlight the entire column. than an ascending sort.
Additional sort options are
A A
3 Click the Sort button on the toolbar. Z_J’I found in the Explore menu.

Sort Data Using the Sort Options
1 Login to PowerPlay and open a predefined user report or a default report.

2 Select the column you will sort the report by placing your cursor in the column header and clicking
once to highlight the entire column.

On the menu bar, click Explore.
Click Sort from the drop-down menu.

In the Sort box, choose from the following options:
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To sort rows in alphabetical order:

Select By label in the Rows section
Select Ascending in the Row sort order section

Select Automatically re-sort if you want PowerPlay to resort the row values when your
report changes.

Click OK.

To sort rows in numerical order:

Select By value in the Rows section

Select a column by which you want to sort:

1 Click on the D button to the right of the Column box to open the
selection list.

2 Highlight the column by clicking once on it in the Column selection box

3 Click OK.

Select either Ascending (starting at lowest value) or Descending (starting at highest value)
in the Row sort order section.

Select Automatically re-sort if you want PowerPlay to resort row values when the report
changes.

Click OK.

To perform no sort on rows:

Select None in the Rows section of the Sort dialog box.

To sort columns in alphabetical order:

In the Columns section of the Sort dialog box, select By label

Select Ascending in the Column sort order section

Select Automatically re-sort if you want PowerPlay to resort the columns when the report
changes

Click OK.

To sort columns in numerical order:

Select By value in the Column section
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e Select a row by which you want to sort

1 Click the D button of the Row box to open the selection list.
2 Click the row you want to sort by in the Row selection box.

3 Click OK.
o Select either Ascending (starting with the lowest value) or Descending (starting with the
highest value) in the Column sort order section.

e Select Automatically re-sort if you want PowerPlay to resort the columns when the report
changes.

e Click OK in the lower right corner of the Sort box.
To sort layers alphabetically:
e Select By labels in the Layers section of the Sort dialog box
e Select Ascending in the Layer sort order section
e Select Automatically re-sort (optional)

e Click OK in the lower right corner of the Sort box.
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Ranking Data

Ranking sorts your data in either ascending or descending order, then assigns a numerical rank order
number to the data, which is displayed in a separate column. You choose whether the highest or lowest
value is assigned the rank order of 1. You can also choose to see only the top or bottom results and how
many you want to see (e.g., top 10, bottom 10, etc.). As with sorting, you can choose to have the data re-
ranked when the report changes.

Rank HE

ik

& Rowlsl By cokumn:

€ Cokmnis) [Total CPS Reparts Indicate _. | ﬂ'

Show ordinals

& Alleg 1.2 3458 I
 Topleg 1.2.3) I : ﬂ
" Bottom [e.g. 4.5 E) Iij

—Which value iz cadinal 1
" Lowest

7 Highest

I o

M Augomsticaly ie-tank
On the menu bar, select Explore - Rank.
2 The Rank dialog box displays.
3 Select to rank either Rows or Columns:
e If you select to rank Rows, you will need to select a Column by which to rank them.
e If you select to rank Columns, you will need to select a Row by which to rank them.
e Click the D button to the right of the By column/By row selection box.
e Select a column/row from the drop-down list.
e Click OK in the Column/Row window.
4 The Show ordinals section determines how many of the ranked categories you will see:
e Select All if you want to see all of the rows/columns.

e If you only want to see a certain number of the top categories, click Top, then select the
number of categories you want to see by using the up and down arrows to the right of the
number selection box. For example, if you select Top and leave the number at 10, you will
only see the top ten categories from your report.

e If you only want to see a certain number of the bottom-ranked categories, click Bottom, then
select the number of categories you want to see by using the up and down arrows to the right
of the number selection box.

5 The Which value is ordinal 1 section determines whether the No. 1 rank is assigned to the
highest or the lowest value. Click Highest or Lowest.
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6 Sort ordinals allows you to list the rank numbers in ascending or descending order:

e Open the selection box by clicking the down arrow to the right of the Sort ordinals selection
box.

e Select Ascending, Descending, or None from the drop-down list.

7 Automatically re-rank allows PowerPlay to re-rank your data when your report changes. It
defaults to allow automatic re-ranking. You can turn this option off by clicking the selection box.

8 Click the OK button in the upper right corner of the Rank window.

You now have a new column on your report called Rank, with the name of the column by which you
ranked in parentheses; i.e., (Rank (column name).

Swapping

You will sometimes see a report where there are more columns than rows and you can’t see all of the
columns without scrolling to the left and right. This makes it rather difficult to analyze the report online.
There is a button on the toolbar that will swap rows and columns for you.

1 Login to PowerPlay and open a predefined user report or a default report.

2 Click the Swap Rows and Columns button @ on the toolbar.

3 Note that only the position of the data has changed. Rows are columns and columns are rows.

Suppressing Data

Suppressing Zero Values
Some reports, or modifications of reports, will contain zero values. In order to concentrate on valid data,
you may want to eliminate these zeroes from your report.

1 Login to PowerPlay and open a predefined user report or a default report.
2 On the menu bar, click Explore.

3 Select Suppress from the drop-down list.

4 Select Zeroes from the selection list.

5 Select Rows and Columns from the drop-down list and click.

80/20 Suppression

PowerPlay offers another suppression option that removes rows and columns that do not contribute
significantly to your report. The 80/20 Suppression option sorts values from the highest to the lowest,
reports those values that contribute to 80% of the overall value, and summarizes the remaining values
into a new category called “Other”. This option allows the user to concentrate on the most significant
values of the report. 80/20 Suppression will not be available for reports containing two or more measures.
To invoke 80/20 Suppression:

1 Login to PowerPlay and open a predefined user report or a default report.
2 On the menu bar, click Explore.

3 Select Suppress from the drop-down list.

4 Select by 80/20 Rule from the Suppression drop-down list.
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5 Select Rows and Columns from the drop-down list.

6 Click OK.

Note that your report now has fewer rows and that a new row titled ‘Other’ is displayed. The ‘Other’
category contains all categories whose values did not contribute to the top 80% of the report total.

Show Values As

PowerPlay provides users with the option of viewing measure values as percentages rather than
numbers. Percentages may provide users with new insight to the data. Consider the value of reviewing
allegation data as percentages by type rather than as numbers. To change your numbers to percentages:

1 Login to PowerPlay and open a predefined user report or a default report.
2 On the menu bar, click Explore.

3 Select Show Values As from the drop-down list.

4

Select % of Row Value, % of Column Total, % of Row Subtotal, % of Column Subtotal, % of
Layer Total or % of Grand Total, whichever is most appropriate.

(3}

Your report now shows percentages rather than numbers.

6 To return to numbers in your report, click Explore on the menu bar, select Show Values As, and
then Value from the drop-down list.

Calculations

PowerPlay does provide the ability to add calculations to your report. You can add, subtract, multiply and
divide, as well as calculate percentages. You can perform calculations on both columns and rows.

To Add Rows
1 Login to PowerPlay and open a predefined user report or a default report.

2 Highlight the rows you want to add together  pwm =]
on the report by clicking once on the row
title. Tip: Use your Ctrl or Shift key on
your keyboard to highlight more than

% 90
¥
H
=

one row.
On the menu bar, click Calculate. Dpeiand
ol R
Select Add from the drop-down list. .
In the Add window, the only option you
have is to give your calculation a Label. Labet

PowerPlay, by default, inserts all of the row | = R T R
labels with the plus sign between them. -

6 Place your cursor inside the Label box and,
holding your mouse button down, highlight the entire label.

7 Press the Delete key on your keyboard.
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8 Type in a label for your calculation. This will be the row title that appears on the report for your
calculated row.

9 Click OK in the upper right corner of the Add box.

10 Your report now has a new row in it. The values and label of the row are italicized to indicate that
they are calculated rows.

To Subtract Rows
1 Login to PowerPlay and open a predefined user report or a default report.

2 Highlight the two rows you want to subtract on the report by clicking once on the row title.
Tip: Use your Ctrl key on your keyboard to highlight more than one row. Obviously, you
can select only two rows to subtract.

Click the Calculate option on the menu bar.

Select Subtract from the Calculate drop-down

menu. Sulbliacl [ 7] =]
Didet QK
5 Inthe Subtract dialog box, select one of the ' Ruochester Region - Syracuze egion s
two options displayed; i.e., subtract the second (" Syacuss Region - Flochestar Region Eancel |
row from the first row, or subtract the first row
from the second row. Dperand
& 1 [eessen
6 Type a title for your calculation in the Label e I— _[
box.
Labst

7 Click OK in the upper right corner of the
Subtract box.

Fochesle Fegion - Syracuss FHegon

To Calculate Columns
1 Login to PowerPlay and open a predefined user report or a default report.

2 On the report, highlight the columns you want to use in your calculation by clicking once on the
column title. Tip: Use the Ctrl or Shift keys on your keyboard to highlight more than one
column.

On the menu bar, click Calculate.
Select Add, Subtract, Multiply, Divide, or any of the Percentage options from the drop-down list.

A calculate dialog box displays. The first section of the box offers several options, depending on
which calculation method you chose. Select the option you want to invoke.

6 Type a title for your calculation in the Label box.
Click OK in the upper right corner of the calculate box.

Note that both the column header (the label you entered) and the values of the new column are
italicized, indicating that they are calculations.
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Percent of Base Calculations

Percent of Base calculations will return the percentage each row makes up of the total. These
calculations will only work on columns or rows where there is a total. So, if you want to see what
percentage of total CPS reports each worker in a unit handled, you would use the Percent of Base
calculation.

1 Login to PowerPlay and open a predefined user report or a default report.

2 Select the column or row on which you want to perform the Percent of Base calculation by
clicking once on the Column/Row title.

3 Click Calculate on the menu bar.

4 Select Percent of Base from the drop-down list.
A new column now appears on your report titled (PctOfBase)(name of column/row)). Both the column
header and the values are italicized, indicating a calculated column.
Changing Displays
Changing your report from the default crosstab into a chart
provides you with a new perspective of the data presented. As
discussed previously, PowerPlay provides nine different chart
formats for your use. To review your data in chart format, simply
click the chart type you want on the toolbar. Legends are

provided with most chart types and all of the modification For large amounts of data
features, including drill-down are available in the chart format. (i.e., more than 12 rows), do
not select a Pie Chart, 3-D Bar
1 Login to PowerPlay and open a predefined user report or or Scatter chart.

a default report.

2 Click an appropriate chart button on the toolbar.

3 Depending on the report you've transformed and the type of chart you've displayed, there may be
another scrolling device at the bottom of your screen. In the lower right corner will be text stating,
“Display __ of __” and up and down arrows to scroll up and down to the other displays. To the
left of the “Display __ of __” text will be the title of the row currently displayed. Click the up or
down arrow to scroll through the different rows of the report.

A problem with PowerPlay charts is that the total or summary column or row is included by default. Your
data will look skewed if individual categories are being compared to totals.
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To remove the summaries from your chart
1 Click Format on the menu bar.

Dezplap Ophons

2 Select Display Options from the drop-down Ciaplay | Primay v | Background | Tes | Statsics Scacing |
list. Siaoling ophions Preyiew
P Uz a sl if equied
3 In the Display tab, click off the Show the el P =
summary line(s) or Show the summary e = =
column(s) options. Note: Selections may vary Masimum cokmns prickect T
depending on the chart type. h: =

¥ Eeep the summany viible

4 Click OK.

There is also a default in PowerPlay limiting the
maximum columns displayed and printed. This will limit
the amount of data you can see on the screen at once
and may result in multiple displays.

To increase the number of columns you can view
on one chart

1 Click Format on the menu bar.

2 Select Display Options from the drop-down 0K ]| Cawa

list.

3 Click the Scrolling tab of the Display Options box.
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4 Using the up and down arrows to the right of the selection boxes, change the Maximum
columns displayed and the Maximum columns printed.

5 Click OK at the bottom of the Display Options box.

The last chart on the toolbar (Correlation Chart) compares two different measures over specified
categories. PowerPlay will default the first measure on the chart to the measure used in the report. If
there are multiple measures in the report, it will show all the measures combined, which doesn’t make
much sense.

To specify which measures you want to compare on the correlation chart
1 Click the Correlation Chart button on the toolbar.

2 There will now be two Measures folders at the end of the Dimension Line.
3 Click open the first Measures folder and select a measure from the drop-down list.

4 Click open the second Measures folder and select a second measure from the drop-down list.

You can change the data displayed in a chart in the same way that you change columns and rows in a
crosstab report. Either drag the new dimension from the Dimension Line to the area in the chart you wish
to replace or use the Dimension Viewer and the Replace Columns or Replace Rows button. You can filter
charts in the same way.

To filter your chart
1 Select the category you want to use as a filter on the Dimension Line; OR select the filter

category in the Dimension Viewer.
2 Click the Filter button. ?I
Layers can be changed, added, or deleted in charts just as you would change them in a crosstab report.

To change layers in your chart

1 Highlight the Layer line at the top of the chart display and press the Delete key on your
keyboard.

2 Select the dimension you wish to use as a layer on the Dimension Line and drag it over to the
Layer button g at the far left of the Dimension Line; OR

3 Select the dimension you want to layer in the Dimension Viewer and click the Replace Layers

button on the vertical toolbar. =

Formatting Data

You have some options for formatting the data and labels displayed on PowerPlay reports and charts.
Column and row titles are called labels, while the measures data (numbers) are called values.

To Format Data
1 Login to PowerPlay and open a predefined user report or a default report.

2 Select the column or row on your report that you want to reformat by clicking on it once to
highlight it. Note: Use your Ctrl or Shift key on your keyboard to highlight more than one
column or row.

On the menu bar, click Format.

Select Categories from the drop-down list.
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5 From the Categories selection list, make your selection as follows:

Labels Only will reformat only your column or row titles.
Values Only will reformat only your measure data.
Labels and Values will reformat both your column or row titles and the measure data.

Default will select the default setting (Arial, Regular, size 10; General format).

6 A Format Categories dialog box is displayed.

Click the Font tab and select the font, font style, and font size in the appropriate boxes.
Open the selection lists by clicking the down arrow to the right of each box. You also
have the option of selecting underlines, overlines, and colors. The viewing box at the
bottom of the Format Categories dialog box displays what your data will look like. Click
the OK button at the bottom of the Font box when you have finalized your selections.
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Click the Format tab (not available for Labels Only) and select the format style you wish
to use for your measure data from the format option list. You can specify the number of
decimal places for your values by using the up and down arrows at the right of the
Decimal places selection box. The box at the bottom of the Format Categories dialog
box displays what your data will look like. Click the OK button when you have made your
selections.

Foimal Calegosiss

[or ] _cowes |

Click the Alignment tab and select, Left, Center or Right Justification for your Row
labels, Column labels and Numbers. Again, the box at the bottom of the dialog box
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displays what your data will look like. Click the OK button at the bottom of the Alignment
box when you have finalized your selections.
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= Click the Patterns tab to select shading and colors for your data. The box at the bottom
of the screen shows you what your data will look like.

= When you have completed making your selections, click the OK button at the bottom of
the Format Categories box.

To Change Report Titles
The predefined user reports have titles already designed for them. However, if significant modifications
are made, the title may need to be changed, too. You can customize a report title as follows:

1 Login to PowerPlay
and open a et | o =z = fe zlu| =|=l [mm) i

predefined user
report or a default
report.

CPS Alle =)
Ferlod Cove

Date of this Report: ODate M iy D
Data As O ODimension0

2 On the menu bar,
click Format.

3 Select Title, Header,
and Footer from the
drop-down list. =

4 Select Title. -
elect Title » LIJ

In the Title dialog
box, change the font, o ] _ coen |

font size, font style,
justification, and color using the toolbar along the top.

6 Place your cursor in the text area of the box. Hold your mouse button down and move your cursor
over the existing title text until it is all highlighted. Press the Delete key on your keyboard. Now
enter the text you wish to see in the title of your modified report.

7 You can add certain information to your report title, such as page numbers, current date, the
Connections or CCRS Data as of Date, etc. Click the Insert button to the left of the format toolbar
and make your selections based on the following:
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Report: inserts the report file name, date, or time. A Date and Time selection box
displays any time you select to insert a date or time value. A selection of formats is
displayed. Highlight the format you want and click OK.

MDC: inserts the cube name, date, time, or description.

Variable: inserts the current measure, period, row, column, or layer; the user or
company name; or the current date or time.

Number: inserts the page number, layer number or report layer.

Dimension: inserts the dimension line or the individual dimensions. You will use this
option to insert the Connections or CCRS Data as of Date. Select individual dimension
and then select the Data as of Date from the dimension listing.

Picture Object: inserts a picture
= A Select Picture File dialog box is displayed.
= Open the selection box by clicking the down arrow to the right of the Look in box
= Navigate to the picture file you want to insert.
= Click Open.

= Size the picture file object to fit in the title text box.

8 When you have completed your report title, click OK in the lower left side of the Title dialog box.
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Module 5:
PowerPlay Reporter

Cognos PowerPlay offers two different modes of data access. PowerPlay Explorer, with which you have
been working thus far, is the data exploration mode of accessing data in cubes. Users are able to drill
down into lower levels of data, combine different dimensions, display data in graphic form, and perform
calculations with the data. However, they are limitations on the specific data that can be displayed, the
actual structure of the report, and the calculations that can be performed. PowerPlay Reporter offers a
more flexible report-building capability that permits complete customization by the users.

PowerPlay Reporter reports do not need to have a uniform structure. Reporter mode offers a flexible
reporting style that gives users complete control over the information displayed in the report. Users have
the ability to add single categories from different levels of the same dimension or from different
dimensions. Complex calculations are also available in Reporter mode. Users should use PowerPlay
Reporter when they know the exact information they want to add to a report, or when they need to
perform complicated calculations.

If you recall from previous modules, default PowerPlay Explorer reports display the first two dimensions in
a cube and the first measure. The categories displayed as rows and columns can be easily changed, as
can the measure. However, the rows and/or columns will display only those categories from a single level
of a single dimension. Summary rows and columns are always included in Explorer reports. Also, values
can be displayed as percentages in Explorer. Single rows or columns cannot be moved or deleted from
Explorer reports.

Reporter reports have no uniform structure. You can start with a blank page and add the categories you
want to see as rows and columns from any level of any dimension, including specific single categories.
Reporter also allows users to delete single rows or columns and to move rows and columns around on
the report. Although summary rows and columns are not automatic in Reporter, there is a toolbar button
available to include summaries when you add categories to your report.

In Explorer, drilling down essentially filtered the report on the category you drilled down on, and displayed
only the lower-level categories for that level. The other categories were eliminated from the report. In
Reporter, drilling down adds the lower-level categories to the report. The other categories remain on the
report and are displayed much like nesting categories in Explorer.

Single rows and columns can be deleted from Reporter reports, and rows and columns can be moved
around on the report. The Replace Rows and Replace Columns buttons on the Dimension Viewer
toolbar are now replaced by Add as Rows and Add as Columns buttons. If you want to replace the
columns on a report, you first need to delete the existing columns. Otherwise, the categories selected will
be added to the existing columns.

There is no feature for showing values as percentages in Reporter, but percentages can easily be
calculated using the enhanced calculation features available.

Accessing PowerPlay Reporter

Users can elect to open a multidimensional cube directly in Reporter mode, or they can open a default
Explorer report and switch to Reporter. Opening directly to a blank Reporter report requires changing file
preferences in PowerPlay. Unfortunately, the changed settings are not maintained in the Citrix
environment and must be reset for each PowerPlay session.

OCFS Data Warehouse Reporting Page 41
Step-by-Step Guide: PowerPlay Rev 11/10/2003



Opening directly to a blank Reporter report:

1 Login to Citrix:

Ve |

Internet

2 Double click the Internet Explorer icon on your desktop. EZiE

3 Click the Favorites button on the Internet Explorer menu bar. Ll

4 Select “Data Warehouse Login” from the drop down-list.

If “Data Warehouse Login” is not listed on the drop-down list:

In the Address line at the top of the Internet Explorer screen, type
http://OCEFSDATAWAREHOUSE.

|Address | http:){OCFSDATAWAREHOUSE

o Click the Go button to the right of the Address box and wait for the page to load.

f»)Gu:u |

e Click the Favorites button on the Internet Explorer menu bar and select Add to favorites
from the drop-down list.

e Inthe Add Favorites dialog box, type “Data Warehouse Login” in the Name field.

Add Favorite 2 x|
Intermet Explarer will add thiz page to your Favaribes list.
[T Make available offiine Customize,.. | Cancel |

Marme: IDala ‘Warehouse Login Create in »» |

¢ Click OK on the Add Favorites dialog box.

5 Enter your NT Username, Password, and Domain in the OCFS Data Warehouse login dialog
box.

QCFS Data Warehouse

Username ||

Passwurdl

Domain [NYSDSSALB

6 Click the Logon button at the bottom of the dialog box.

7 Click OK on the Confidential Warning screen.
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‘warming: This spstern and all data accessed through it are confidential and
proprietary to the State of Mew Yaork.access iz limited to autharized employess
and legally designated agents and only for authonized purposes. Also these
systems acoess data maintained by other government groups.access thereto
must also be authorized. Unauthorized access to or release of State of New vork
syztems/data or other government data mag result in civil liability and/or criminal
prozecution. If you suzpect unauthorized activity iz occurring at this device ar
hawve questions ag to authorization.call 1-800-643-0356 and leave a message.
Any use of this system may be accessed.read,copied,and used for any purpose
the State of Mew York deems proper - users have no expectation of privacy. Use
of the system whether authorized or not,constitutes express consent for the State
of Mew York to intercept.copy.and reuse any material entered on this terminal.
Thiz notice shall not be interpreted to compromize the rights of nonuzer data
subjects.

8 The OCFS Data Warehouse welcome screen is displayed. To the left of the screen are icons for
PowerPlay, Impromptu, Cognos Cubes, and Training Database.

“ m

T Drive CFSR PIP

st |

9 Double click the PowerPlay icon to launch the application.

10 Click Close on the Cognos PowerPlay 6.6 Welcome screen.
11 Select File > Preferences on the menu bar.

12 Click the Startup tab of the Preferences dialog box.

13 Deselect the Create an Explorer report by default option.

14 Click the OK button at the bottom of the Preferences dialog box.
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Preferences HE

Alignment I Dimenzions I Directories I Diizplay I Faont I Farmat I Options I Palette I
Patterns I Guery I Fiank. I Sart Startup |Suppress I FPage Defaults

V' Mavimize the repart at startup

[~ Mavimize the application at startup

™ Create an Explorer report by default

¥ Show the Welcome to PowerPlay dialog

()8 I Cancel

15 Click the New button on the toolbar. g

16 In the Choose a Local/Remote Cube dialog box, make sure “Remote” is selected in the Access
section.

17 Click the arrow to the right of the Connect window. ﬂ

18 Select Datawarehouse from the connections listing.

19 Select a cube in the selection window of the Choose a Remote Cube dialog box.

20 Click the OK button.

21 If the Cognos Common Logon dialog box appears, enter your Cognos User ID in the User ID
window, enter your Cognos Password in the Password window, and then click the Log On
button.

To switch to Explorer from Reporter:
Assuming you are logged in to PowerPlay and have an Explorer Report open (e.g., the TRN Allegations
Report). You want to use the same cube, but you want to create a new customized report:

1 Click the Explorer € = Reporter button on the toolbar. 24
2 Select Edit > Select = All on the menu bar.

3 Press the Delete key on your keyboard,

Building a Reporter Report

Reporter offers several more toolbar buttons in the Dimension Viewer. These buttons are enabled when
you select a category in the Dimension Viewer. They are meant to be used in combinations to add single
categories, lower- or lowest-level categories of a dimension, sums, averages and/or percentages as rows
or columns to your report.
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Adding Columns/Rows

To add lower-level categories of a dimension as columns or rows to your report:

When you add a dimension to a Reporter report, only the highest-level category is added to the report.
For example, if you selected the Age Range at Intake dimension to add to your report, and clicked the
Add as Columns button, you would see only the single column “Age Range at Intake”. If you want to add
in lower-level categories of the dimension, you need to indicate which level of the dimension you want to
display. There are two toolbar buttons available to invoke lower-level categories. The Next level children
of button will bring in the next level down in the selected dimension’s hierarchy. As in the previous
example, if you selected “Age Range at Intake”, clicked the Next level children of button, and then
clicked the Add as Columns button, you would then see the actual age range categories as columns.
The Lowest level children of button adds the lowest level categories of the selected dimension to your
report. If you select a year under the Date folder, then click the Lowest level children of button, and
then click the Add as Rows button, you would see the months of the year (which is the last level of the
Date dimension) as rows on your report.

1 If the Dimension Viewer window does not appear on the left-hand side of your screen, click the
Dimension Viewer button on the toolbar. L

2 Select a dimension in the dimension viewer.

3 Click either the Next level children of @I or the Lowest level children I@ of button:

¢ Next level children of — will bring in the categories from the level beneath the summary level
of the dimension. For example, the categories directly beneath Statewide are Upstate,
Downstate, Regional Offices, Statewide Agencies, and State Offices. If you selected the
Statewide dimension, clicked the Next level children of button, and the Add as Columns

.
@" button, you would see those five categories as columns on your report.
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¢ Lowest level children of — will bring in the categories from the lowest level of the selected
dimension. For example, the lowest level of the Statewide dimension in the Allegations cube
is Victim ID. If you selected Statewide, clicked the Lowest level children of button, and the
Add as Columns button, the districts would be displayed as columns on your report, except
for your home district, where Victim ID’s would be displayed as columns. Remember that
your Cognos User ID and Password give you permission to see summary data to the district
level for all districts and detailed data for only your district. So, for individual users, the lowest
level of Statewide includes all counties and all victims in the user’s county.

e |tis recommended that users review the levels of each dimension by clicking the [+ to the left
of each folder to determine what level of data is needed in the report. Remember, too, that
many dimensions have only one level of detail (e.g., the Gender Dimension contains only two
values — Male and Female — and no hierarchy). Thus, it makes no difference whether Next
level children of or Lowest level children of is selected. There is only one level of detail to
report.

'.
4 Click the Add as Rows Iﬁ" or the Add as Columns @" button on the Dimension Viewer
toolbar.

Of course, users should add the dimension with the most lower-level categories as rows and the
dimension with the lower number as columns. This will result in a more user-friendly report.

To add single categories as rows or columns to a report:

In PowerPlay Reporter, users can select single categories from one dimension or single categories from
multiple dimensions to add as rows or columns to a report. For example, a user may need to see the
number of white children, the number of Asian children, and the number of Hispanic children discharged
from care during a particular period of time. These categories belong to two different dimensions in the
Discharges cubes. In Explorer, only one dimension at a time can be added as rows or columns. But in
Reporter, single categories from multiple dimensions can be added. Specific categories from one
dimension can also be added. For example, if a user wished to see only discharges from Group
Residences and Group Homes, those two categories could be selected and added to the report. In
Explorer, all categories from a single dimension are added, without the ability to delete single rows or
columns. Adding single categories to a Reporter report is accomplished by first selecting the categories in
the Dimension Viewer, and then clicking the Add as Rows or Add as Columns button.

Assuming a PowerPlay cube has been opened in Reporter mode with a blank report:

1 Open the Dimension Viewer window by clicking the Dimension Viewer button on the toolbar. ﬂ

2 Open the dimension folders by clicking the H to the left of each folder. Open sub-folders
contained within a dimension folder by clicking the [+ to the left of the sub-folder.

Select a single lowest-level category by clicking on it once.
Hold down the Ctrl key on your keyboard.

Select another lowest-level category from the same or from another dimension by clicking on it
once.

6 Repeat the selection process (holding your Ctrl key down) until all of the categories you wish to
see are highlighted in the Dimension Viewer.

=
7 Click the Add as Rows IE" or the Add as Columns |g” button on the Dimension Viewer
toolbar.
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Adding Layers to a Reporter Report

Layers, or a third dimension, can be added to a Reporter report in much the same way as in Explorer.
The difference is that you must indicate what level of the dimension you wish to add (i.e., use the Next
level or Lowest level children of button). Single categories from the same or from multiple dimensions
can also be added as layers.

To add lower-level categories of a single dimension:

1
2

3

Select a dimension folder in the Dimension Viewer by clicking on it once.

Click the Next level children of &'I or the Lowest level children of I@ button. Again, opening
the folders and sub-folders will help you in determining which level you want to add.

Click the Add as Layers |§| button on the Dimension Viewer toolbar.

To add single categories:

1

a b~ WO DN

In the Dimension Viewer, open the dimension folder or folders that contain the categories you
wish to see as layers.

Click on the first category once to highlight it.
Hold down the Ctrl key on your keyboard.
Click on the next category once to highlight it.

Repeat the selection process (holding down your Ctrl key) until all of the categories you wish to
see are highlighted,

Click the Add as Layers |§| button on the Dimension Viewer button.
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Filtering a Reporter Report

Filtering a Reporter Report is accomplished in the same way as in an Explorer report. In Explorer, you
can filter on multiple categories, but you have to do it one at a time. In Reporter, you can select multiple
categories and filter on them all at the same time.

1 In the Dimension Viewer, select the category or categories you wish to use as filters. To select
more than once category, hold down your Ctrl key and click once on each category to highlight it.

2 Once all filter categories are highlighted, click the Filter ?I button on the Dimension Viewer
toolbar.

Adding Summaries to a Reporter Report
In Explorer, summary rows and columns are automatically included when you add a dimension to your

report. Summaries are not automatic in Reporter. However, there is a Sum of| Z  button on the
Dimension Viewer toolbar that can be used in conjunction with the Add as Rows or Add as Columns
button to add a summary of the categories selected to your report.

-
The Each @ button on the Dimension Viewer toolbar is designed to be used in conjunction with the
Sum of, Average of, and Share of buttons. Clicking any of the automatic calculation buttons results in
adding just that calculation (sum, average, or percentage) as a row or column to your report. If you also
want to see the individual categories as rows or columns, you can select the Each button in addition to
the Sum of, Average of, or Share of button.

1 In the Dimension Viewer, select the category or categories you wish to add as rows or columns to
your report. Select more than one category by holding down the Ctrl key on your keyboard and
clicking on each category. You can also select all of the lower-level categories of a single
dimension (or multiple dimensions) by clicking once on the dimension folder (hold your Ctrl key

down to select more than one dimension folder) and then clicking the Next level children of @I
or the Lowest level children oflgl button.

2 Once all categories are highlighted in the Dimension Viewer, click the Sum of| Z putton on the
Dimension Viewer toolbar. This will add a summary of the categories selected to your report.

"

3 If you also want to see each single category as a row or column, click the Each IE button on the
Dimension Viewer toolbar. If you're interested in only the summary of the selected categories, do
not click the Each button.

.
4 Click the Add as Rows IE" or Add as Columns @" button on the Dimension Viewer toolbar.

The summary row or column will have the default label of the calculation used to produce the sum. For
example, if you had added a sum of the Lowest level children of the gender dimension as columns to
your report, the column title would read “Male + Female”. This protocol can be quite cumbersome for
other dimension summaries. Consider, for example, the label that would result when adding a summary
of the Goal dimension. Thus, it is beneficial to know how to change the labels on these summary rows
and columns.

To change summary row/column titles:
1 Right click on the column or row title of the summary row or column.

2 Select Rename Label from the drop-down list.
3 Enter a new label in the New category label window of the Rename Label dialog box.

4 Click OK on the Rename Label dialog box.
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Adding Average Calculations to a Reporter Report

An average of selected categories can be easily added to a Reporter report by use of the Average of (4
button on the Dimension Viewer toolbar. The selected categories are added and the total is then divided
by the number of categories. For example, in the report below, there are six categories of age range (0-2,
3-5, 6-9, 10-13, 14-17, and 18+). The total of all genders is 226. When this total is divided by the number
of age range categories (6), the result is 37.67, rounded up to 38.

Fernale Male All Genders
0-2 TE 9E 172
3-5 47 46 93
£-9 56 69 125
10-13 a7 8y 144
14-17 104 117 22
18+ 0 1 1
Awarage(l-2, 3-5, 6-9,10-13, 14-17, 18+) 57 69 126

1 Select the categories you wish to see on your report in the Dimension Viewer.

e Select single categories from the same or multiple dimensions by clicking once on a
category, holding down your Ctrl key and clicking on each category.

o Select lower levels of a single or multiple dimensions by clicking on the dimension folder (use
ﬁr Ctrl key to select more than one dimension) and then click the Next level children of
T

or the Lowest level children of I@ button on the Dimension Viewer toolbar.
2 Click the Average of ﬁ button on the Dimension Viewer toolbar.

+
3 If you also want to see each individual category selected as a rows or column, click the Each Iﬁ
button.
4 If you also want to see a summary or total row/column of the categories selected, click the Sum
of| Z putton.

=
5 Click the Add as Rows IE" or Add as Columns @” button on the Dimension Viewer toolbar.
Adding Percentage Calculations to a Reporter Report

Percentage calculations can be easily added to a Reporter report by using the Share of % putton on the
Dimension Viewer toolbar. This feature calculates the percentage each single category is of the total
dimension. Thus, if you selected only some of the categories in a dimension, but not all, the total of the
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percentages will not equal 100%. The total percentage will reflect the percentage that the total of all of the
selected categories make up of the total dimension. For example, in the report shown below, only three of
the six Final Discharge Reason categories have been added as rows to the report. The different Share
calculations listed represent the percentage each category makes up of the total Final Discharge Reason
dimension. The Total % calculation represents the sum of the three Share calculations. Thus, the three
categories selected represent 88.05% of the total Final Discharge Reason dimension.

Female Male All Genders
Dizcharge to ParentiLegal Guardian 172 213 a5
Discharge to Adult Residential Care 0 0 0
Cizcharge to Adoption 1 3 4
Cizcharge to Independent Living 2 4 g
Total Dimension 175 220 395
AveragedDischarge to ParentiLegal Guardian, Disct 44 kil a4
Share(Discharge to ParentflLegal Guardian, Goal) a0.59% a81.20% 101.79%
Share(Discharge to Adult Residential Care, Goal) 0.00% 0.00% 0.00%
ShareiDizcharge to Adoption, Goal) 0.29% 0.72% 1.02%
Share(Discharge to Independent Living, Goal) 0.59% 0.56% 1.55%

1 Select the categories on which you wish to calculate percentages in the Dimension Viewer.Select
single lowest-level categories by clicking on a category once to highlight it. Hold your Ctrl key
down and click once on each category you want to see in the report until all categories are
highlighted.Select lower levels of a dimension or dimensions by clicking once on a dimension
folder in the Dimension Viewer to highlight it. Use your Ctrl key to select more than once

dimension. Click either the Next level children of |ﬁ|| or the Lowest level children of@
button on the Dimension Viewer toolbar.

2 Click the Share ofﬁ button on the Dimension Viewer toolbar.

3 If you also want to see the individual categories as rows/columns on your report, click the Each

%
Iﬁl button. Note: This will actually result in two rows/columns for each category—a Share of
row/column and a row/column displaying the actual measure value for each category.

4 If you also want to see a summary row/column, click the Sum of Z  putton on the toolbar. This
will actually result in two total rows/columns — one that totals the measure values of the selected
categories and one that totals the percentages of the selected categories. Unfortunately, this
total percentage, or Share of, calculation is incorrect.

5 If you also want to see an Average calculation of the selected categories, click the Average of

2 button on the toolbar. This will result in two average calculations on the report — one averages
the measure values of the selected categories and the other averages the percentages of the
selected categories. Unfortunately, the average percentage calculation is incorrect.

=
6 Click the Add as Rows IE" or Add as Columns @” button.

Again, the summary row or column is labeled with the actual calculation of the total (e.g., Return to Parent
+ Release to Relative). The average rows or columns are also labeled with the average calculation (e.g.,
Average (Return to Parent, Release to Relative)). The percentage rows or columns are also similarly
labeled (e.g., Share (Return to Parent, Final Discharge Reason)). These labels can easily be changed
using the Rename Label option.

Page 50 OCFS Data Warehouse Reporting
Rev 11/10/2003 Step-by-Step Guide: PowerPlay



Right click any row or column title.

Select Rename Label from the drop-down list.

W N -

Type a new title in the New category label window.

4 Click the OK button on the Rename Label dialog box.

Deleting Rows and Columns from a Reporter Report

As noted previously, Reporter gives you the option of deleting single rows or columns from the report.
Explorer does not provide this function except for individual measures added as rows or columns to a
report. In Reporter, you can delete single rows or columns or delete all rows and columns. You can even
clear the entire report and start over.

To delete single rows or columns:
1 Click on a row or column title to highlight the entire row or column.

2 To select more than one row or column, hold down the Ctrl key on your keyboard and click on
each row or column.

3 Press the Delete key on your keyboard.

To delete all rows or columns:
1 Select Edit © Select on the menu bar.
To delete all rows in your report, select Rows from the fly-out menu.
To delete all of the columns in your report, select Columns from the fly-out menu.

To delete the entire report, select All from the fly-out menu.

a A WO D

Press the Delete key on your keyboard.

Edit ‘iets Imsert Explore Calculabe  Format  Tools  SWindow H

- Undo Delete Selected Categaries Ckrl+2 = E} Ig ﬂlﬁ

&

Fedn (k{4
clis e
(RO, (b -
Paste Chrl+Y
Paste Special...
Delete 3
Find Ckrl+F
Rows
Rename Label... Fz Colurmins
LEwELS
al Chrl+a

To Summarize Selected Columns or Rows

As mentioned previously, the calculations of total percentages or average percentages are incorrect in
Reporter. You can delete these incorrect rows or columns by clicking on them and pressing your Delete
key, as shown above. But how do you get a correct total or average percentage calculation?

1 Highlight the rows or columns for which you want a total on the report. Use your Ctrl or Shift key
to highlight more than one row/column.

2 Select Calculate > Add on the menu bar.
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3 Inthe Add dialog box, type a description for the row or column in the Label window.

4 Click the OK button on the Add dialog box.
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€] Shiare(H eturrto Parent, Final Discharae Feason] I Cancel |

— Operand

& Humben I

i [Eateqan: I |
Label:
ITDtaIZi
™ Group

Intersected Categories

In Explorer, we could combine dimensions on a report by nesting categories. We have the same option in
Reporter, but there is an additional feature called Intersected Categories, which combines categories
from different dimensions into a new category. For example, you can intersect Agencies with their
Statewide locations, resulting in a new category that combines the district and the agency (e.g.,
ERIE.N11 — Lincoln Hall). In the example below, the cell value displayed represents the number of
children discharged from a particular agency in that district for a given month.

2002idan 2002Feb 2002/ar 2002601 2002fMay Total 2002
ALBANY . UMK - Unknown 1 ] 1] 1] 1] i
FRAMELIMN . LINK - Unknown 1 1} 1} o 1} 1
Worker: 628 . UMK - Unknown 0 1 1] 0 1] 1
MONTGOMERY . M24 - Vanderheyden Hall 1] 1] 1] 1 1] 1
REMSSELAER . 104 - Parsons Child & Family Center 1] 1 1] 1] 1] 1
REMSSELAER . M24 - Yanderheyden Hall 2 1] 1] 1] 1] 2
SARATOGA . M40 - Mortheast Parent & Child Soc 1 1] 1] 1] 1] 1

1 Select the dimensions you want to intersect in the Dimension Viewer. Use your Ctrl key to select
more than one dimension.

Click either the Next level children of &'I or the Lowest level children of@ button.
Click the Intersect ﬂ button on the Dimension Viewer toolbar.

If you want to see a total of the intersected categories, click the Sum of| 2 button.

a ~h W D

If you want to see the individual intersected categories as rows or columns in addition to the sum,
+
click the Each Iﬁ button.

6 If you want to see an average value for the intersected categories, click the Average of i
button.

7 If you want to see percentages for the intersected categories, click the Share of % putton.

=
8 Click the Add a Rows IE" or Add as Columns @” button.
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Ranking Categories

Ranking assigns an ordinal value (number assigning a rank order) to values in a selected row or column.
Users can assign ordinals to all values or to either the top or bottom values, and sort the values in either
ascending or descending order. The sample report below has ranked the various district offices in order
from highest to lowest by the number of overdue CPS reports at the end of the period. Albany, with 206
overdue reports, has the highest number and is assigned the ordinal 1. The district with the next-highest
number of overdue reports, Erie, is assigned the ordinal 2. The rows are also sorted in ascending order,

according to the rank ordinals.

Total CRS Total CRS Rank (Total CPS
Reports Active at Reports Reports
End of Period | Owerdue on Last | Owerdue on Last
Day of Feriod Day of Period)
Albany 254 206 1
Erie 2449 152 2
Rensselaer 114 95 3
Monroe 142 g2 4
Cnondaga 133 74 ]
Broome 12 79 5
Washingtan 62 52 7
Hudson a7 49 g
Oneida g7 49 g
Schenectady B0 36 10
Allegany 43 34 11
Miagara 3] a0 12

You can also elect to see just the top or bottom ordinals and can specify how many of those ordinals you

want to see. The report below shows only the top 10 ordinals of the same report.

i Total CPS Total CPS Rank (Total CPS
|Reports Active al Repons Repors
End of Period  Owerdue on Last Overdue on Last
Day of Period Diay of Period)
Albany | 254 206 1
Erie 249 154 K
Rensselaer 114 a5 3
Monroe | 142 82 4
Onandaga 133 74 ]
Broome 112 78 5
Washinglon B2 a2 T
Hudson B7 449 B
Onelds I BY 49 B
Scheneclady 36 10

| G0

1 On a Reporter report, select a column or row on which you want to base your ranking by clicking

once on the title.

2 Select Explore = Rank on the menu bar.
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3 The Rank dialog box is displayed:

a.

The Rank section determines what will be ranked by what. For example, the illustration
below will rank all of the rows in the report by the values in the column Total CPS Reports
Overdue.

The Show ordinals section determines how many of the ordinals will be displayed on the
report.

i. All will display all of the ordinals and will thus show all of the existing
rows/columns.

ii. Top will display only the top ordinals and their corresponding rows/columns. You
must also decide how many of the top ordinals you want displayed. The
illustration below will show only the top 10 ordinals and their respective
rows/columns.

iii. Bottom will display only the bottom ordinals and their corresponding
rows/columns. Again, you decide how many of the bottom ordinals you want to
see.

The Which value is ordinal 1 section allows you to assign ordinals from the lowest to
the highest or from the highest to the lowest. The number 1 will be assigned to the
column/row with the highest value or the lowest value, depending on what you select
here.

The Sort ordinals section allows you to sort the report in ascending or descending order,
based on the rank ordinals assigned.

The Automatically re-rank option will do just what it says. The report will be re-ranked
automatically each time it is run. This is especially useful when cubes have been updated
and the new data results in a different rank order.

4 After making your selections in the Rank dialog box, click the OK button.

Rank [ ? ] x|
' Rows) By colurnn:
¢ Column(z] ITDtaI CP5 Reports Dwerdu J ﬂl
— Show ordinalz

C Allfeg1,2.3.456 IT-"B
i ' [10 =
" Bottom [2.a. 4. 5. ] [10 =

—which walue iz ordinal 1
0 Lowest

% Highest

Sort ordinals:

I.t’-‘«scending j

v &utomatically re-rank
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Percent of Base Calculations

Since Reporter does not give you the option to show values as percentages, it will be beneficial for users
to be knowledgeable about Percent of Base calculations in Reporter. This feature calculates the
percentage each category represents of a base or total category.

1 Select the row or column on which to calculate percentages by clicking once on the column or
row title. In the example below, the column Total CPS Reports Overdue has been selected:

Total CPS Total CPS

Reports Active at Reports
End of Period  |Owerdue on Last

Day of Period

Albany 254 206
Erie 249 1562
Rensselaer 114 45
Monroe 142 a2
Cnondaga 133 74
Broome 112 79
Washington 62 52
Oneida ar 49
Hudson ar 48
Schenectady 60 36
COtsego 16 ]
Calumbia 17 6
Herkimer 10 5

2 Select Calculate > Percent of Base on the menu bar.

3 In the Percent of Base dialog box, click the arrow ﬂ to the right of the Select a base value
window.

4 Scroll down the base value list until you find the total category.

Percent of Base [7]
Select a bage value:
Albarwy -
Buffala R egional Office - Cancel |

| Unknown

5 Enter a description for your Percent of Base calculation in the Label window. Otherwise, the label
will default to PctofBase (name of column or row).

(=]

Click the OK button on the Percent of Base dialog box.

Percent of Base

Select a base walue: ok

IAIban_l,l j |

Labet Cancel

|3é of Tatal
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Total CPS Reports | Total CPS Reports % of Total
Active st End of | Crverdue on Last
Period Dray of Period

Columbia 27 15 0.91%
Rochester Regional Office 4 2 0.10%
St Lawrence 36 15 0.76%
Hamitton 2 1 0.03%
Jetfferson 25 13 0.66%
Chenango =] 1 0.05%
‘Yonkers Regional Office 16 =] 0.45%
Divigion For Yaouth (Dfy) 1 1 0.05%
Madizon 63 45 2.43%
State Certral Register 1 1 0.05%
Osyvego 54 23 1.16%
Schuyler 10 1 0.05%
Chautaucua 47 17 0.56%
Whaming 5] 1 0.05%
Sullivan 20 10 0.51%
Cattaraugus 42 29 1.47%
Seneca 30 20 1.01%
Office Of Confidential Investigstions 32 14 0.71%
Westchester 130 59 2.93%
State a a 0.00%
Schoharie 9 0 0.00%
Buffalo Regional Office u] u] 0.00%
Unknosyn 1] 1] 0.00%
Total MY State 4 0BE 1979 100.00%
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Custom Exceptions

In Reporter, you can apply a custom exception to highlight exceptional values in a report, entire rows or
columns that contain exceptional values, or only values in the rows and columns you have selected. For
example, a custom exception has been applied to the Percent Overdue column in the report below. Any
value over 50% has been shaded in gray and the value printed in red.

Total CPS Total CPS Percent Overdue
Reports Active at Reports
End of Period  Cverdue on Last
Day of Period

Albany 254 206 81.10%
Clinton 34 16 47 .06%
Caolumbia 17 B 35.29%
Delaware 14 2 14.29%
Essex 21 15 71.43%
Frankiin 11 1 9.09%
Fulton 34 25 73.53%
Greene 7 1] 0.00%
Hudsaon 87 49 56.,32%
Montgomery 19 10 H2.63%
Otsego 16 9 56.25%
Rensselaer 114 95 83.33%
Saratoga 27 7 25.93%
Schenectady 60 36 60.00%

1 Select the report, rows or columns to which you want to apply a custom exception.
a. To select all rows, click Edit > Select > Rows on the menu bar.
b. To select all columns, click Edit > Select > Columns on the menu bar.

c. To select the entire report, click Edit > Select 2> All on the menu bar.
2 Select Explore > Custom Exception on the menu bar.

3 Enter a name for your custom exception in the Exception name window.

Escopiioe paes:

r'-"enc' I j

4 In the Apply to section, do one of the following:

a. Click Selection to apply the custom exception to what you have already selected on the
report.

b. To apply the custom exception to all columns in the report, click All Columns.
c. To apply the custom exception to all rows in the report, click All Rows.

d. To apply the custom exception to all values in the report, click All.

Apply o
® Sulpchior |
Al o &l columrs
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5 If you select All Rows or All Columns, you can select a driving category. PowerPlay compares
the values in the driving category to the range of values specified in the Value or style ranges
section. If a value in the driving category falls in the range, the entire row or column containing
the value is highlighted.

a. Check the Based on category option.

[ Baved on cobegone

b. Click the D button to the right of the Based on category window.

c. Select a row or column from the selection window of the Choose Category dialog box.

d. Click OK on the Choose Category dialog box.

Choose Category E2
Bazed on: 0

G —

due on Last Day of Period Cancel |

]

Percent Overdue

6 Enter the range of values you want the custom exception to be applied to in the From and To
windows in the Value or style ranges section.

Walug of sl tanges

Erom: Tx Siple:

| 248 = ED = | Low Sasoratc Excepiions =)
| ] ;l BB ﬂ IIlnch Automatic irr.:pln:n:ﬂ
|¢ ﬂ |1 _ﬂ IBa: Qe _ﬂ
| 21 || -
| | | | ) =

7 Select a style you wish to app I. / to f[hg values within the specified range. To review the styles,
click the Styles button 21 peneath the Style window.
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Styles HE I
Style name :
J C | |
— Description SNCEl
K N Bodiy... |
¥ Font
. fidd
v Alignrment 4|
v Pattern Welete |
Prewview:
1,000,000
[ Shared

e The style is displayed in the Preview section of the Styles dialog box.
o To change the style, click the Modify button.

e You can change the font, font style, and font size on the Font tab of the Format
Categories dialog box.

Format Categories n ﬁ
Font I Alignment | Pattemns I
Font
T Arial Black,
T Avial CE J
T Arial CYR _I
Ower or underline: Lolor:
[ Hare> =] [ -]
™ Shikethrough
1l]l]l]|]l]l]‘
e |

e You can change the justification (left, right, center) of the column or row labels and of
the cell values by clicking the Alignment tab.
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Format Categories ﬂ E

Font  Alignment |Pattems|

Bow label

’7(:' Left " Center " Right £ Default ‘
LColumn label

’7(" Left ¥ Center = Right ' Default ‘
Humber

’7(“ Left 0 d " Right " Default ‘

1000000 ‘

Cancel |

e You can change the pattern of a style by clicking the Patterns tab.

Format Categories 7]

Font |A|ignmenl F'allemsl

Pattemn:

f I
Foreground colar:
[ — -]
Background colar:

[—]

1000000 ‘
Cancel |

e When you have completed your style modifications, click OK on the Format
Categories dialog box.

8 You may enter more than one value range and more than one style in the Value or style ranges
section. In the example below, values between .249 and .500 will be highlighted in green, values

between .501 to .749 will be highlighted in red, and values between .750 and 1.00 will be
highlighted in yellow.
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Custom Exceptions HE

Exception name: Apply |
IVarious -
Clear |
Apply to
& Selection Al Add
Al rows Al columng Delste |
™ Based on cateqony: LCloze |

| N

—Walue or syle range:

Erom: To Shyle:

|.248 j |.5D j ILowAutomat\c Exceptlonsj
I.SD‘I j I.?49 j IHighAutomalic Exceptionsj
[75 =l =] [BadNews =]
| =l =l |
| =l =l |
Macro I j I j
[+ Shared

9 Once you have entered all of your Custom Exception definitions, click the Apply button on the
Custom Exceptions dialog box.

10 Click the Close button. Your report should now display highlighted values in the ranges defined.

Other Calculations in PowerPlay Reporter

PowerPlay Reporter offers all of the same calculation choices as PowerPlay Explorer, with some
additions. In Reporter, you can calculate maximum, minimum, averages, and accumulations, in addition
to the Add, Subtract, Multiply, Divide and Percent calculations found in Explorer.

|galculate Format  Tools  Window

I add.
: H

| Calculake  Format  Tools  Window o subtract...

. add £ Divide...

; = Tultiply. ..

. Subtract... —

! Divide... Percent of Base. ..
MUItiPI':-"- . Cumulative Percent of Base. ..
P . Mazimurm. ..
Eercent. .. Minir ..
Percent of Base. .. Byerage...
Cumulative Percent of Base. ., Accumulate
RD||U|:|. . Exponentiate...

— Bl

RERCEnt GROH . Percent Growth, ..
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Minimum and Maximum

You can identify the highest or lowest value in a selected range of categories by using the Maximum or
Minimum calculation options. This feature adds another row or column to your report labeled Maximum or
Minimum. In the example below, showing Total New CPS Reports Assigned, the maximum column
displays the highest number of new CPS reports assigned by month and district. The minimum row
displays the lowest number of new CPS Reports assigned.

20020an 2002/Feh 2002/Mar 2002Anr 2002/May 20020un Maximum
Alhary 36 17 ar 42 29 29 43
Clinton 14 ] 12 el 17 16 17
Columbia " il 4 7 4 i 1"
Delaware 3 4 1 B B B B
Essex B 2 3 k) 41 B 8
Franklin B 2 3 4 g 10 10
Fulton 5 11 g 8 14 10 14
Greene 4 4 4 11 4 a 11
Harmilton 1) 0 1 1 1 1) 1
Hudson 19 26 el 23 et} 25 35
Montgomery 2 5} B 12 ] 32 12
Otsego 1 7 8 B 8 a 8
Rensselaer 22 17 22 13 15 15 22
Saratoga 17 18 19 10 17 [ 13
Schenectady 10 14 15 15 16 18 18
Schoharie ) 0 1 B 9 3 9
[Minimum | 0 0 1 1 1 0 1

1 Select the rows or columns for which you want to calculate a minimum or maximum.

Select Calculate > Maximum (or Minimum).

Enter a description in the Label window; otherwise, it wil
Maximum (Albany, Clinton, Columbia)).

Click the OK button.

Maximum

— Order

| default to the actual calculation (e.g.,

%1 1 avimuralElintar, Ealumbia, Delawars, Bssey, Fre

) W awimumnlErtan, Ealumbia, Delaware, Essex, Fre

Canhicel |

— Operand
% Humites

—

) Eateqan: I

L

Label:

IMaHimum[EIinlon, Caluribia, Delaware, Ezzex, Frankling

™ Group
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Averages

You can add an average calculation to a PowerPlay Reporter report by using the Average of i button
on the toolbar. However, if you forget to click the Average button when you add your rows and columns,
you can always use the Average option on the Calculate menu. This feature can be used to calculate
average percentages, which are incorrect using the Average button. In the example below, the Average
(Share (Albany, Albany Region, etc)) added using the Average button on the Dimension Viewer toolbar
is incorrect. We can delete this row and add a correct average percentage calculation using the

Calculate menu option.

Total New SRS CPS Reports Total CPS Total PS5
Reports Closed During |Repaorts Active at Reports
Assigned This Period End of Period | Owerdue on Last
FPeriod Ciay of Period
Shara(Essex, Al 2.26% 2.32% 2.54% 2.94%
Shara(Franklin, £ 2.50% 2.64% 0.94% 0.63%
Share(Fulton, Alk 6.23% 412% T.63% 8.81%
Share(Greene, A 3.30% 2.59% 3.08% 2.52%
Share(Harmilton, 0.24% 0.23% 0.00% 0.00%
Share(Hudsan, £ 14.00% 12.56% 14.99% 16.14%
Share(Montgome 3.02% 3.24% 1.74% 0.21%
Share(Otsego, A 3.06% 2.97% 2.28% 1.68%
Share(Renssela 9.33% 12.14% 6.83% 6.92%
Share(Saratoga, B.01% 7.46% 4.69% 2.94%
Share(Schenect: 9.05% 8.20% 1017% 2.39%
Share(Schoharie 1.74% 1.67% 0.54% 0.21%
Share(Warren, A 4.34% 3.89% 2.01% 0.42%
Share(Washingt 4.95% 477% B.57% 9.85%
Aoerage(Sharei 11788.89% 11988.89% 4150.00% 2650.00%

1 Select the rows or columns for which you want to calculate an average. Use your Ctrl or Shift
key to select more than one.

2 Select Calculate > Average on the menu bar.

|galculate Format  Tools  \Window
i Add..

. Subtract...
! Divide...

Ay

Accumnulate
Exponentiate. ..
Bl

Eercent Gratthn,..

Multiply. ..
Percent...
Percent of Base. ..
Cumulative Percent of Base. ..
Mazxirnurn, .,

Minirmurn. ..

3 In the Average dialog box, enter a description for your average in the Label window. Otherwise,

the description will default to the actual calculation.

4 Click OK on the Average dialog box.

OCFS Data Warehouse Reporting
Step-by-Step Guide: PowerPlay

Page 63
Rev 11/10/2003



Average

r— Order
0% Ly erane(Sharelblbany, AlbanFEgion], Shareli:

1 oy eranelE harelblbany, Albary Fegion], Sharsli:

Cancel |

— Operand

&) Kumter I
(=) Categon; I _I

Label:
|.&verage %

[~ Group

Accumulations

You can include a column or row in your report that shows a running total of a selected category. In the
example below, a running total column has been added to the report that accumulates the number of new
CPS reports assigned to Hudson County over the months of 2002.

Unit: 001 Unit: 002 | Unit: 003 | Unit:006 | Unit: 008 || Unit: 160 | Unit: ILW | Unit: STF Total Accurnulate(T
otal)

2002/Jan 0 3 5 B 0 3 1 1 19 19
2002Feh 1 7 3 g 0 8 i} 2 26 45
2002Mmar 0 5 4 10 1 1 1 8 30 75
20027Apr 0 B 7 5 0 1 i 4 23 98
2002/May 0 1 2 B 1 5 i 3 18 116
YTD 1 22 2 32 2 18 2 18 116 232

1 Select the column or row that you want to accumulate.
Select Calculate > Accumulate on the menu bar.

To change the column or row description, right click on it and select Rename Label from the
drop-down menu.

4 Type a new description in the New category label window.

Click OK on the Rename Label dialog box.
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Module 6:
Managing PowerPlay Reports

This module will cover all the skills you will need to print, distribute and save your PowerPlay reports.
There are a number of options in PowerPlay for saving your reports in other file formats such as Excel
files, ASCII files and PDF files (viewable in Adobe Acrobat). You can also e-mail reports you have saved
to your T: Drive from your local desktop. There are some things to consider when printing reports, too,
since you will not in most cases want to print an entire report, and should not print directly from
PowerPlay in Citrix. All of these options are discussed below.

Saving PowerPlay Reports

As has been noted previously, you cannot save modified reports as the original predefined user report
name in the Data Warehouse folder. The predefined reports are “read-only”, which means they can only
be read, thus preventing you from saving any changes you make. If you make modifications to a
predefined user report and want to save the modified version, you can give it another name and save it to
your T: Drive to prevent corrupting the original report.

1 Login to PowerPlay and open a predefined user report or a default report.
2 Make modifications to the report as needed.
3 Select File > Save As on the menu bar.
4 A Save As dialog box is displayed on your screen.
Lave As EHER
Save jn; Desktop j £ Ef- Save |
o e cace|
=i -_ ' Home e [T} .. |
Rz |

File name: IN CPS Reports Proceszed During the Period Statewide Totals

Save as lwpe: IPowerPIay Feport [*.ppr] j

]

5 Navigate through the file directories by clicking the drop-down arrow -| to the right of the Save in
window.

6 Select your T: Drive and an appropriate folder from the directory selection list.

7 Type a report title in the File name box.
8 Click the Save button in the upper right hand corner. ﬂl

Saving PowerPlay Reports as Other File Types

PowerPlay offers a variety of file types for your use in managing and distributing reports. If you need to
further manipulate the data, or add more data to it, you can save the report as an Excel workbook. You
can save reports as ASCII files if you need to import it to another application (Excel, Access) or if you
need to send it to a colleague who does not have the PowerPlay or Excel applications. There is another
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option available for saving your report in PDF (Adobe Acrobat) format, which is excellent for saving
reports in presentation format, but does not allow for much manipulation. PDF format is also
recommended for printing reports. All of these options are discussed below:

To Save PowerPlay Reports as Excel Files

1

10

Login to PowerPlay and open a predefined PowerPlay report
or a default report.

Modify the report as necessary.
Click File > Save As on the menu bar.

In the Save As dialog box, open the directory listing by
clicking the arrow = to the right of the Save in box.

Navigate to your T: Drive and select an appropriate folder.
Enter a name for your file in the File name box.

Open the file type listing by clicking the arrow | to the right
of the Save as type box.

Select Microsoft Excel Workbook [*.xIs] from the listing.

Click the Save button in the upper right corner of the box.
Save

You will get a message stating that your report has been
successfully saved as an Excel file. Click OK.

PowerPlay

Feport successiully saved az Excel file.

Note:

It is a good idea to drill down
and/or filter your report to
retrieve the minimum amount
of data needed to fit your
requirements. Saving large
amounts of unnecessary data
in Excel format drains system
resources and is much harder
to manipulate.

Note:

It is always helpful to assign
names to files that are easily
recognizable to you.
Remember that file names
can be as long or as short as
you like.

You can now login to Excel and open the file you just saved.

To Save PowerPlay Reports as ASCII Files

1 Login to PowerPlay and open a predefined user report or a default report.

2 Modify the report as needed.

3 Select File > Save As on the menu bar.

4 In the Save As dialog box, open the directory listing by clicking the arrow | to the right of the

Save in window.

5 Select the appropriate directory and folder from the T: Drive.

6 Type a name for your file in the File Name box.

7 Open the file type listing by clicking the arrow =l to the right of the Save as type box.

8 Select Delimited ASCII Text File [*.asc] from the listing.

9 Click the Save button in the upper right corner of the Save As dialog box.ﬂl
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To Save PowerPlay Reports as PDF Files

1

H WO DN

© 0 N O O

Login to PowerPlay and open a predefined user report or a default report.
Modify the report as necessary.
Select File > Save As from the menu bar.

In the Save As dialog box, open the directory listing by clicking the arrow ™ o the right of the
Save in box.

Navigate to your T: Drive and select an appropriate folder.

Enter a name for your file in the File name box.

Open the file type listing by clicking the arrow | to the right of the Save as type box.
Select PDF Format [*.pdf] from the listing.

Click the Save button in the upper right corner of the Save As dialog box.

Publishing PowerPlay Reports to HTML Format

You can save PowerPlay reports in HTML Format for viewing inside a web browser, like Internet Explorer.
This format can be used in a local intranet, so that specified users can access the report through typical
browser commands, like links. Presently, OCFS does not support a local intranet for publishing reports,
however this functionality should be noted.

1 Login to PowerPlay and open a predefined report or a default report.
2 Modify the report as needed.
3 Select File > Publish as HTML... on the menu bar.
[REN Edit Wiew Inssit Epploe Calculsle Fomat JTook ‘windos Help
Hew.. Clrlss
D Cirds0
Choze
Cloze &)
Save Cirl+5
Save s
Pubbsh to Liphart .,
Pubkeh 5 HTHL
Publizh a: Brigfing Book...
Duplicale &z *
4 In the Publish As HTML dialog box, open the directory listing by clicking the drop-down arrow ™
to the right of the Save in: box.
5 Navigate to your T: Drive and select an appropriate folder.
6 Enter a name for your report in the Prefix box.
7 Click OK.
8 A status box called Publish to HTML will appear indicating that the report is being published.
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Publizh to HTML

Layer 20f B

9 To view your report, open Internet Explorer.

10 In the Address line, type in the name of your report, including the directory path

J Address I@ T:OCFS Data Warshouse) Test HTML HTM

11 OR find the file in Windows Explorer (choose the Main File only), and double-click.

Folders x|, — [ Mame  * | Size |
Desktop =] ihE’ @ Goal Report 54 KB
2y My Documents = B Goal Repart 4 KB
g Iy Computer OCFS Data @Goal Report 16 KB
B 3% Floppy (A1) Warehouse il left L KB

= Local Disk (C:) ‘@PDFTest 25 KE
&8 Compact Dise (D) This falder is Online. S right LKE
52 MoreAccenture on 'sconnapp @ o 1KE
2 602365 on 'Sconnappdey 1L Test HTML &] Test HTMLDBOD] S KB
52 dataon 'Isconnappdevl'l (1) HTML Docurnent &] Test HTMLDBOOZ SKE
52 apps on 'sconnappdevt () Modified: 6/18/2002 9:23 AM &] Test HTMLDBOO3 SKE
E2 Cdram on 'Sconnappdey ' (K @ Test HTMLDEOD4 5 KB
% Connections on 'sconnappdet. Size: 408 bvtes @
=52 992365 on 'frpcfsalaavishs ; Test HTMLDENNS 5B
" B3 AppData aktributes: {normal) @Test HTMLDEBOOS KB
D COGMOS @ Test HTMLDIOOL 1 KB
1 FNDNT &]Test HTMLDIDOZ LKB
{55 OCFS Data Warehouse &]Test HTMLDIOO3 LKB
L0 WINDOWS &1 Test HTMLDIOO4 1KB

i D WORD @Test HTMLDIOOS 1 KB

[-{&8 Contral Panel &] Test HTMLDIOOG 1 KB
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Printing PowerPlay Reports

Due to the limitations of the Citrix environment, reports should not be printed directly from PowerPlay.
Printing may not work correctly from the Citrix window, so reports should be saved as a file type that can
be opened and printed from your local desktop. *.PDF (Portable Document Format) is recommended for
this purpose.

Because a PowerPlay report is often larger than what appears on your PC screen, it is important that you
specify exactly what you want to print. Remember that PowerPlay reports can be hundreds of pages long,
so only print the pages or section you need.

It is also recommended that you save a copy of the report as *.PPR (PowerPlay report format) prior to
saving as any other file type, so that you do not lose your original report).

After completing the formatting of your report in PowerPlay

1
2

0 N O

9

Select File > Save as on the menu bar.

In the Save As dialog box, open the directory listing by clicking the down arrow | to the right of
the Save in box.

Navigate to My Home Drive (T:) and an appropriate folder.

Save in: £ OCFS Data Warehouze j

Desktop
@ T:M Drive

=2 by Home Dirive (T:]

Open the file types listing by clicking the down arrow ™ o the right of the Save As Type box.
Select the file type PDF File [*.PDF] from the drop-down listing.

Save as twper | PowerPlay Beport [ ppr) j

PowerPlay Beport [*.ppr]
FowerFlay Portable Report [*. ppx]

Type a name for your report in the Name field.
Click Save.
Click the Ctrl and Esc keys simultaneously to return to NT.

Select Programs from the Start pop-up menu.

10 Select Adobe Acrobat Reader from the Programs listing.

11 In Adobe Acrobat Reader, select File > Open on the menu bar.

12 In the Open dialog box, open the directory listing by clicking the down arrow | to the right of the

Look in box.

13 Navigate to your T:Drive and select the *.PDF copy of your report.

14 When the report is open in Adobe, select File © Print.

OCFS Data Warehouse Reporting Page 69
Step-by-Step Guide: PowerPlay Rev 11/10/2003



15 Enter the page numbers of the report you wish to print in the Print dialog box.

Pt HH

— Prirter
Mame: I\\SEDNNAPPDEVH\BMI j Froperties |
Status:  Ready ™ Reverse pages
Type: HF Lagerlet 4100 PS ™ Prirt as image
Wwhere:  172.28.21.192:Raw ™ Pririt ta file
— Print Range Copies and Adjustments
Al ) Selented pages/araphic: Mumber of copies: m
' Current page
(*' Pages from:l‘l— bio: IB— ¥ Shiink oversized pages to paper size
Print: IW ™ Expand small pages to paper size
V' Auto-ctate and center pages
¥ Comments
— PostScript Option Preview —11.00—3
Pririt Method: | Language Level 3 j T
v Optimize for Speed a50 EIEI
¥ Download Asian Fonts [ Save Printer Memary )[
Color Managed: On printer
Units: Inches Zoorn: 100.0%

Frinting Tips | Ok I Cancel

16 Verify your printer selection.

17 Click Print.

Sending PowerPlay Reports via E-mail

You can send a PowerPlay report to a colleague using Microsoft Outlook from your local desktop. Since
reports cannot be e-mailed from the Citrix environment, they must first be saved to the T: Drive before
leaving Citrix. In order to e-mail a PowerPlay report, you must be on your local desktop. Your local
desktop can be accessed with a Citrix session open, or after completing a session working with
PowerPlay.

Remember that a file saved as a *.ppr file type will require access to the PowerPlay application to open it.
Both *.ppr (PowerPlay reports) and other file types can be saved and e-mailed to other users. If you are
unsure if your intended recipient can access PowerPlay, the file type recommended is *.PDF (Portable
Document Format). Every Connections computer has Adobe software installed and can open and print
this file type.

Having completed formatting your report
1 Select File © Save as on the menu bar.

2 In the Save As dialog box, open the directory listing by clicking the down arrow | to the right of
the Save in box.

3 Navigate to My Home Drive (T:) and an appropriate folder.
4 Open the file types listing by clicking the down arrow * o the right of the Save As Type box.
5 Select a file type (example PDF File *.pdf)
6 Type a name in the Name field.
7 Click Save.
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8 Press the Ctrl and Esc keys simultaneously in order to return to NT.
9 Click Start > Programs - Microsoft Outlook.
10 In Outlook, select File > New Mail Message.

11 Enter the recipient’s e-mail address in the To: field.

& Untithed - Mezsage [Rich Text]

[ = I A 7= - IO B s o T 7

E-.\.,_,.,:-ﬁ-tﬂt.n} = | o - | T | S o i, L_l.......:

Toy - ||I
e |l
subgect: |
ﬁ =l

CPE Flapan
Distarrinaliooe Den..

12 Type an appropriate subject in the Subject field.
13 Enter a message if desired.

14 Click Insert - File.

15 In the Insert File dialog box, navigate to your T: Drive and select the report you wish to e-mail.

16 Click Insert.
17 More than one report can be sent at one time by repeating the Insert command.

18 Click Send to send your message and attached report.
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Module 7:
Getting Help in PowerPlay

Cognos provides extensive documentation to help you modify and manage your PowerPlay reports. In
addition, the OCFS Data Warehouse has provided this step-by-step guide and a class manual. The
documents can also be found in the training database folder on the conncord1 server.

To Access Documents in the Training Database Folder:
1 Login to Microsoft Word.
2 Select File > Open on the menu bar.

3 Navigate to the Training Database folder on Conncord1, as follows:

Open m
& |® ¥ 5 B - Toolks -

Loak in: @ Training Database
Desktop -~
EQ_J, Iy Cormputer
= 31 Floppy {4
= Disk 1 ()
= Disk 2 (D)
52 Gg2365 on 'Sconnappdev1ils...
2 Data on 'Sconnappdevl' (13
=2 &pps on 'Sconnappdevl’ (11
=2 cdrom on 'Sconnappdevl’ (K t
&8 Compact Disc (R1)
My Network Places
Q Entire Metwork
-,l'!' Microsoft \Windows Netwaork
é ASC
Q Conncordl
k2§ Training Database;
'@ My Documents
FTP Locations

&) add/Modify FTP Locations -
FIETIEET |

4

j & Open 'l
Files of type: IAII Word Docurments j Cancel |

4 Select a document from the Training Database listing and click the Open button on the Open
dialog box.
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open T |
Look in: I@ Training Database ;l - | @ X O - Tools -

Archive

Catalogs

Cubes

Reports

Class Manual Report Mock Ups:

Class Manual

Cognos maller

My DoCLments Complete Document

Diata WarehoLise Presentation Handout

File name: I j 8 Onen '|
Files of type: IAII ward Documents j Cancel |

To Access PowerPlay Help

Help Topics: PowePlay Help

5 Click Help on the menu bar and select Conterts | Index | Find |

Contents and Index from the drop-down list. : j
Click & bopic, and e click Display. D dick another 85, much s Indes.

6 PowerPlay Help generally has three different [ @ Evpicre Data =
tabs — Contents, Index, and Find: “-'E"‘E‘ Dela
raph Fepots
« Contents is a topical listing of Help & Daph oot Dz
subjects. Expand these topics into more [3 Compere Two Measues
detail by double clicking on them. Select a 2] Shows the Mix 1 8 Fie o Chustesed Bas Display
. . . _ﬂ Find & Tiend in & Display
topic and click the Display button at the (2] Show Moss then O Type of Dikply
bottom of the Help screen. . Zplay ) St it s 0 D
[ Change Daplay:
¢ Index is an alphabetical listing of topics [B Showvsuss in a Display
covered in the PowerPlay Help % :Jm':-swi L-nusmailf-ln-sw
documentation. You can scroll down the list e =
to find the topic you need or you can type [ o | oi. | oo |

the first few letters of the word you're
looking for in the text box at the top of the screen. Select a topic from the listing and click the
Dizplay

Display button on the bottom of the screen.
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Help Topics: PoweaPlay Help Em

Corbents Irdex | Find |

1 Tupe the fust few lsites of the word pou'ie looking for
[l

2 [hck the rdes eriry wou want, and her cick, Display.

defriton
. bles
openeg
savIg
Lokt Biles
debrion
oo Bt
dedipition
W h
definition
iqd lies
definiticn
lac fies
lae lies
dsfinition ;I

Disy | | cance |

e Find is a search feature where you can type in a word in Section 1, or scroll through a word
listing in Section 2. Topics pertaining to your word selection will appear in Section 3. Select a

topic from Section 3 and click the Display button.

Dizplay

Help Topics: PowerPlay Help [12]

Eontentsl Index ~ Find I

1 Type the word(z) you want to find

I j Clgar

2

elect some matching words to narrow your search

Options...
Fityd Simmilar..

it ot

PP

Febuild...

3 Click a topic, then click Display

Add a Layer

Add a Layer

Add a Layer

Add a Title, Header, and Footer

Add a Title, Header, and Footer

Add a Title, Header, and Footer ;I

IESD T opicz Found | I All words, Begin, &uto, Pause |

Dizplay I Fifits.. | Cancel |
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7 The PowerPlay Help topics returned to you generally have three tabs:

e Steps provide step-by-step
instructions for completing a
task.

o Description provides more
detailed information
concerning the topic and other
topics you can refer to for
even more information. Click
on any word in green and a
description/definition of that
word is displayed.

e More Info provides Notes,
Tips, What if's, and Related
Topics. Related Topics will
provide another list of topics to
which you can refer if you still
haven’t found the information
you need. Select a topic from
the Topics Found list and
click the Display button.

Dizplay

B PosssPlay Help

Drill Through to PowerPlay
Stanz | Descripton | Mo info |

1 IF pou sss deling Swough bo 8 repon o cube sesocmsted with & messurs, saich io that mesues ﬂ
Yot can eithe charge the meanae wied in the repod o add d 20 & nowy, cobaan, o2 by IF pou
add the meanae &z 8 o, o o , the cuasor o mast b on the meanas you want o
v by e il frough, IF the cumo box i not on the mesmas. PowePlay uies e nesgies
showm i the mesnaes folder.
2 Sleci e cull o calegoey labed Sl wous mand So dell Teough bom,
PraveiFlay usas the mslected call o lsbal s the bass ior e sspot o cube pou e delirg
Humagh o, For sxampls, § pour ispod thows 1355 1598 and 1557 i the iowe. and the seiscied
cull iz 1997, PovesiPlay Hliess the dillthiouagh repoi b showy 1957 data
F  From the Explors menu. click Dl Through
IF Thsam st perveral impots o cubee svalabls, the Dnll Theough disiog bos sposars. Lzs Bo seisct
tha repal o cubw
4 0 IhDﬂThvd!dabgbuv sppaai, doubls-cick the impon o cube that vou veant
W yous eebect & 1o, Powedlay opere the Explorer o1 Reports repon Blersd o malch. a5
much & poeplie. he cursm Bos pooition and derssneor brs of e fisd pol
»  FomePlay ignoms ey dimertions in the rewly opensd repal thal do nol match |l na
calngoins malch ihe calugaes m e divsnso ke aopasi ot they vais wher e ol
ik e Sl .:I

E PowsiFlay Help

Drill Through 1o PowarFlay

Saeps  Desonintion I e Irlo l

Moy o et o el il ion i ancdher cube pois can dtbe cill Hhioagh bo el £ oo -
of Flipoear 1epod that uset & cllgind cube o dall lhvough 10 anolher cubss Buan tha one wou an

LEIE o o sl

Dl iomgh b5 arwlhén PossrPlay spal fin iher ® ppi o oo ioimat] when

= e othes repar contare: dats bom arolhen oabe that vou resd [ snalpee snd compss o the
dala in your opsr ieposd

«  pond vl b Bk thes vepents Fot pous cLnenl PomerPlay sesion 20 thet pou can sxplons The dabs m
orw repor aned see the allacts m the cther ispoi
Nuotec "a'hen pou changs the dimermion ine in one iepost. the dimersion ine snd dala changs in
e il Franugh seport when pou click the Dinll Theough bution

*  po s prfamlis weth the dnchas of dais in the ofher oubs

Hote: Since e adminshator hes et up the report for pou. you donl reed 1o stast from soraich
vailhy unfamiier data

* e mdminiheior b perioened calboulstions
Dl $rwough 5o & cube when

+  pou vk 1o explions the datsn the other cube walhout & predefined view of the dats set up by
tree dmindstaton ﬂ

E FowerFlap Help
Help Topcs|  Back Opion: | Glasaiy
Dwill Throwgh to PowerPlay

Singe | Dewiphon Mot lnia |

Netes ﬂ

*  Vou can oill fwough bo as meny cubes snd reports as pou computer can hands and the
admirisralor has sek up for pow

» | pous opemn - repoit by using the Open commeand =nd |ater drll Bwough o Hes separt: fiom anothes
vegeoit, pous wall harve o copees of the same seport. Howeves, only She copy of the repor Shal pou
dall=d Hhiough bo el be finked
For exampls, pou opsn a report called Qd-Saes and a report calied 1997-5ales. vou del theough
Trom 19975 akes b Q8-Salen You nosw have s copes of the 04-5ales report open. Orly the
opd) st was opened by dullieg Brough ko e 19975 ales report & inked to 1997 -Cales.
e pon changs the deraion e m 19975 akes ard chck, the Ol Thecugl buthon, onlp de
copd of 04-5 ales thal pou dulled uouagh bo & updated, unlzss pou bave shaned dimenson:
T o
Thas et joosii il Hearaih from it corban 8 ek ond 10w S one COLINE

& e pond s & Cobsnn i a FRepoits sepor that b part of & delldows path, B bk betwssn
I ol Bhad s mosed and P cobuning 19 8 ight i loet Yiou sall nol b shis b dall up
g i sad patty T he alsn apples ko delles dosen or & 08 oF bt

o Do dall hecugh [0 & iepos oncs, PossrPlay slomalc sl (8kes pou o the cae sspod the

Tf Illlle.nl_u cick ".“.D-'....TW'.LW Todid Ilhl.ld! Iy & cilleand repord, Clikeclck tha Dl _:_J
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8 At the top of the PowerPlay Help screen are four buttons that will help you navigate the Help
documentation:

Help Topics brings back the Content/Index/Find Help dialog box so that you can start
another Help search.

Back takes you to the Help screen you had opened prior to the current one.
Options provides several different options:

Annotate allows you to append your own notes to the Help topic. A text box pops up, into
which you can enter any note pertaining to the Help topic. Click the Save button when
you're finished. A green paper clip now appears to the left of the Help topic. When you
click on it, your notes are displayed.

Copy copies the text of the Help topic to your clipboard. You can then paste it into a
Microsoft Word document on your local desktop and print it.

Print will attempt to print the help topic directly from Citrix, which is not recommended.

Font allows you to change the font in the Help text to a larger or smaller size. You have
to select text in the topic before you can apply any font size change here.

Glossary brings up a word list from which you R B Glossary M[=TE
can select. When you click on a word in the list, Help Topics| ool Optiory
a definition of the word is displayed. The —l [af{efciole|Fla{ult[alc]1
alphabet buttons at the top of the screen will N|o|pla|a|s|T|u|v|w] x|y
advance the word list to that section beginning I:“fﬂe ﬂ
with the selected letter. ' 301 Bar Display
A
Acinate
Advanced Subge Reloibon
falll-E
Allgeation
Altemate Dirill-Diosm Fah
Anceston Categon
= This Ape:
hiz )
Acenciaiion

Association

The process of defining the
relationships beteesan an fam in a
Transformer mods| (such as a |=vel)
and its associated columns. afiributes
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Appendix A:
OCFS Data Warehouse PowerPlay Cubes

Appendix A1:
CPS - Investigations Cubes

The Investigations Cubes contain information on the status and determinations of all CPS Reports from
the Connections system. CPS Reports are defined as the Intake (INT) stage plus its accompanying
Investigative (INV) stage, if one exists. CPS Reports classified, as Additional Information (ADD),
Duplicate (DUP) and Withdrawn (WTH) are not included in the Investigations Cubes at this time.

e For the sake of expediency and size minimization, separate cubes have been created for
each. An additional cube contains summarized data for all years and can be used for
trending.

The Dimensions incorporated in the Investigations Cubes are defined as follows:

Statewide Indicates the geographical location of the incident. The hierarchy of
the Statewide dimension is as follows:

Statewide Upstate, New York City, State Offices, Statewide
Agencies, Regional Offices

SRegion  Albany Region, Buffalo Region, New York City
Region, Rochester Region, Syracuse Region,
Yonkers Region, Regional Offices, Statewide
Agencies, State Offices

SCounty  Albany, Clinton, Columbia, etc.
S Unit
> Worker

LCPS Report

Date Based on the Intake Start Date of the CPS Report. The hierarchy of
the Date dimension is as follows:

e Year
e Quarter
e Month

NCANDS Reporter Type Indicates the type of individual responsible for reporting the incident,
according to the federal guidelines for the National Child Abuse and
Neglect Data System. The hierarchy of this dimension is as follows:

e Mandated/Not Mandated — indicating whether the
individual is required by law to report any incidents of
child abuse.

o Reporter Type — indicating a category into which the
reporter falls, depending on whether or not he/she is
mandated (i.e., Child Day Care Personnel, Education
Personnel, Anonymous or Unknown Reporter, Friends
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and Neighbors, etc.).

By Region Albany Region, Buffalo Region, New York City Region, Rochester
Region, Syracuse Region, Yonkers Region, Regional Offices,
Statewide Agencies, State Offices

YCounty
S Unit
S Worker

- CPS Report

By County Albany, Allegany, Bronx, etc.
Y County
S Unit
“Worker

S CPS Report

Connections Data as of Indicates the latest date on which the Connections Data included in
Date the cube was updated. There will only be one date in this dimension.

The Measures included in the Investigations Cubes are:

Total New CPS Reports The total number of CPS Reports assigned to a worker during
Assigned This Period the period.

Total Initial CPS Reports A subset of Total New CPS Reports Assigned This Period, this
Assigned This Period measure reflects the number of new initial (INI) CPS Reports
assigned during the period.

Total Subsequent CPS A subset of Total New CPS Reports Assigned This Period, this

Reports Assigned This measure reflects the number of new subsequent (SUB) CPS

Period Reports assigned during the period.

CPS Reports Closed Total number of CPS Reports for which a determination was

During Period made (i.e., investigation proves it to be Indicated or Unfounded)
and approved at any time during the period.

CPS Reports Closed The average number of days, during which the report was active

During the Period - Avg. for the period, based on the Intake Start Date. This is a

Days calculated field: (Date Closed - Intake Start Date)/Total Number

of CPS Reports
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Total CPS Reports
Indicated

Total CPS Reports
Unfounded

Initial CPS Reports
Indicated

Initial CPS Reports
Unfounded

Subsequent CPS Reports
Indicated

Subsequent CPS Reports
Unfounded

Total CPS Reports Closed
This Period

Total CPS Reports Active
in This Period

Total CPS Reports Active
at Beginning of Period

Total CPS Reports Active
at End of Period

Total CPS Reports
Overdue on Last Day of
Period

A subset of Total CPS Reports Closed During Period, this
measure reflects the total number of closed CPS Reports for
which an Approved Determination Code of “Indicated” (IND) has
been assigned for the period. A determination has been made
by the local CPS office that some credible evidence exists to
support an incident of child abuse and/or maltreatment. The
caseworker’s supervisor has approved the finding.

A subset of Total CPS Reports Closed During Period, this
measure reflects the total number of closed CPS Reports for
which an Approved Determination Code of “Unfounded” (UNF)
has been assigned for the period. A determination has been
made by the local CPS office that no credible evidence has
been found to substantiate the report of child abuse and/or
maltreatment. The caseworker’s supervisor has approved the
finding and the report is closed on the Connections system.

A subset of Total CPS Reports Closed During Period, this
measure reflects the number of CPS Reports originally
categorized as Initial Reports (Intake Type Code = INI) that were
subsequently determined as “Indicated”. Initial reports present
information that contains a reasonable cause to suspect child
abuse and/or maltreatment where no open or active case exists
in the SCR.

A subset of Total CPS Reports Closed During Period, this
measure reflects the number of CPS Reports originally
categorized as Initial Reports (Intake Type Code = INI) that were
subsequently determined as “Unfounded”.

A subset of Total CPS Reports Closed During Period, this
measure reflects the number of CPS Reports originally
categorized as Subsequent Reports (Intake Type Code = SUB)
that were subsequently determined as “Indicated”. Subsequent
reports involve either new allegations or a new incident of the
same allegations occurring under an open SCR case number.

A subset of Total CPS Reports Closed During Period, this
measure reflects the number of CPS Reports originally
categorized as Subsequent Reports (Intake Type Code = SUB)
that were subsequently determined to be “Unfounded”.

The number of CPS Reports for which a determination was
made and approved on the investigation at any time during the
period.

The total number of CPS Reports that were active at any time
during the period.

The total number of CPS Reports active as of midnight on the
first day of the period.

The total number of CPS Reports that were active as of midnight
on the last day of the period covered.

The total number of CPS Reports that were still active at the end
of the period where the number of days between the Intake Start
Date and the Period End Date is greater than 60 days.
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Total CPS Reports Active
in This Period - Avg. Days

Total CPS Reports
Opened for Service in
This Period

Family Indicated

Family Unfounded

Foster Care Indicated

Foster Care Unfounded

Day Care Indicated

Day Care Unfounded

Other DC/FC Indicated

Other DC/FC Unfounded

Institutional Abuse
Indicated

Institutional Abuse

The average number of days during which the active CPS
Reports were open. This is a calculated field: (Data Warehouse
Update Date -Intake Start Date)/Total CPS Reports Active in
This Period.

The total number of CPS Reports that were closed for
investigation and opened for services during the period.

A subset of Total CPS Reports Indicated, this measure reflects
the total number of Indicated reports (coded “CPF”) where the
subject was a member of the child’s family.

A subset of Total CPS Reports Unfounded, this measure reflects
the total number of unfounded reports (coded “CPF”) where the
subject was a member of the child’s family.

A subset of Total CPS Reports Indicated, this measure reflects
the total number of Indicated reports (coded “CPD”) where the
subject was a foster parent.

A subset of Total CPS Reports Unfounded, this measure reflects
the total number of unfounded reports (coded “CPD”) where the
subject was a foster parent.

A subset of Total CPS Reports Indicated, this measure reflects
the total number of Indicated reports (coded “CPD”) where the
subject was a day care provider.

A subset of Total CPS Reports Unfounded, this measure reflects
the total number of unfounded reports (coded “CPD”) where the
subject was a day care provider.

A subset of Total CPS Reports Indicated, this measure reflects
the total number of Indicated reports (coded “CPD”) where the
subject was other than a foster parent or day care provider.

A subset of Total CPS Reports Unfounded, this measure reflects
the total number of unfounded reports (coded “CPD”) where the
subject was other than a foster parent or day care provider.

A subset of Total CPS Reports Indicated, this measure reflects
the number of CPS Reports with determinations of “Indicated”
where Institutional Abuse was investigated. IAB cases are
investigated by the OCFS regional offices and cover allegations
of child abuse and/or maltreatment involving a child placed in
the care of a facility and an employee/volunteer at the facility.

A subset of Total CPS Reports Unfounded, this measure reflects

Unfounded the number of CPS Reports with determinations of “Unfounded”
where Institutional Abuse was investigated.
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Appendix A2:
CPS - Allegations Cubes

The Allegations Cubes contains detailed information on the specific allegations contained in CPS Reports
from the Connections system. Substantiated, unsubstantiated and undetermined allegations are all
included. An undetermined allegation would be any allegation included on an open CPS Report as of
midnight of the last day of the period covered. An allegation consists of a subject, a child and an
allegation type. Any one investigation may have multiple allegations. For example, an allegation of

inadequate guardianship of three children on the part of the mother and father would result in 6
allegations.

e For the sake of expediency and size minimization, separate cubes have been created for
each. An additional cube contains summarized data for all years ad can be used for
trending.

The Allegations Cube is categorized according to the following dimensions:

Statewide Indicates the geographical location of the child involved in the
incident. The hierarchy of this dimension is as follows:

Statewide Upstate, New York City, State Offices,
Statewide Agencies, Regional Offices

L Region  Albany Region, Buffalo Region, Rochester
Region, Syracuse Region, Yonkers Region

Y County
S Unit
S Worker

Y Victim Name

By Region Albany Region, Buffalo Region, New York City Region,
Rochester Region, Syracuse Region, Yonkers Region, Regional
Offices, Statewide Agencies, State Offices

Region
S County
S Unit
—Worker

L Vietim Name

By County Albany, Allegany, Bronx, etc.
County
SUnit
—Worker

S Victim Name
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Date

Allegations

Gender

Race

Disposition Status

Based on the Intake Start Date of the CPS Report. The
hierarchy of the Oral Report Date dimension is as follows:

e Year— 1998, 1999, 2000, 2001, etc.
e Quarter— 1999 Q 1, 1999 Q 2, etc.
e Month — 1999/Jan, 1999/Feb, etc.

Category of physical abuse in which a child is involved. The
hierarchy of this dimension is as follows:

Allegation Type A broad grouping of specific physical
abuse allegations (i.e., Physical
Abuse, Neglect or deprivation of
necessities, Medical Neglect, Sexual
Abuse, Psychological or emotional
maltreatment, Other). These
categories follow the national
guidelines rather than New York State
guidelines for physical abuse
groupings.

L Allegations Specific types of physical abuse
(i.e., Lacerations, Bruises, Welts;
Excessive Corporal Punishment;
etc.)

Indicating the gender of the child involved (i.e., Male, Female,
and Unknown). There is no hierarchy for this dimension.

Indicates the ethnic origin of the child involved in the incident.
The hierarchy for this dimension is as follows:

Racial Group A broad category of specific ethnic
groups (i.e., White, Other, Unknown,
Black or African American, American
Indian or Alaska Native, Asian)

b Race Specific ethnic groups to meet federal
guidelines (i.e., Native
American/Alaskan Native, African-
American, African-American-
Caucasian, etc.)

Indicates the status of the allegation. The hierarchy of this
dimension is as follows:

Undetermined/Determined

Indicates that the allegation has either been determined
as being substantiated or unsubstantiated or has yet to
be determined

Substantiated/Unsubstantiated
Indicates for determined allegations whether the
incident has been substantiated by investigative
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findings or unsubstantiated. Determinations of
substantiated allegations indicate that some
credible evidence exists to support the allegations
of child abuse/maltreatment. Determinations of
unsubstantiated allegations indicate that no
credible evidence exists to support the allegations
of child abuse/maltreatment.

NCANDS Reporter Type Description of the type of individual who has reported the
incident. The hierarchy of this dimension is as follows:

Mandated/Non-Mandated
Indicates whether or not the individual is required by law to
report incidents of child abuse/neglect.

Reporter Type

A specific type of individual based on National
Child Abuse and Neglect Data System guidelines
(i.e., Child Day Care Personnel, Education
Personnel, Medical Personnel, etc.)

Age Range at Intake Age range in years of the child as of the date that the report is
taken (i.e., 0 to 8, 9 to 16, 17 and Over, or Unknown). There is
no hierarchy for this dimension.

Connections Data As Of Indicates the latest date on which the Connections Data
Date included in the cube was updated. There will only be one date in
this dimension.

Measures included in the Allegations Cube are as follows:
e Child Count — the number of children involved in the particular allegation
e Allegation Count — the total number of allegations

e Report Count — number of reports
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Appendix A3:
CCRS - Admissions to Foster Care Summary Cubes

The CCRS Admissions to Foster Care Summary Cubes provide data on total children admitted to foster
care for a specified period of time. The universe for this repot consists of children who have a movement
code of “M910” with a corresponding activity date that falls within the specified time period.

Dimensions included in the CCRS Admissions Summary Cubes are as follows:

Statewide Geographical location of the child involved in the incident. The
hierarchy of this dimension is as follows:

Upstate/New York City
Counties

Date Date on which the most recent “M910” activity occurred. The
hierarchy of the date dimension is as follows:

e Year
Quarters
Months

e  Current Month

e Last Month

e QTD (Quarter to Date)

e  Prior QTD (Prior Quarter to Date)

e QTD Grouped (Quarter to Date Grouped — prior
quarter compared to current quarter)

e YTD (Year to Date)
e  Prior YTD (Prior Year to Date)

e YTD Grouped (Year to Date Grouped — prior year
compared to current year)

Agency Where Placed Code plus the name of the agency with which the child was
placed. There is no hierarchy for this dimension.

Facility Type Describes the facility setting. There is no hierarchy for this
dimension. Facility types include the following:

Foster Boarding Home
Approved Relative Home
Institution

Group Residence

Group Home

Supervised Independent Living Program
Agency Operated Boarding Home
e Other

Direct/Voluntary Indicator Indicates whether the agency is a District/Direct (D) of Voluntary
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Agency (V).
e Direct
e Voluntary

e Unknown

Race Describes the racial origin of the child. There is no hierarchy for
this dimension. Races include the following:
e White
e African-American
e Asian
e American Indian or Alaskan Native
e Other
e Unknown
Hispanic Origin Indicates whether or not the child is of Hispanic origin. There is

no hierarchy for this dimension. Values include Yes and No.

Gender Describes the gender of the child. There is no hierarchy for this
dimension. Values include Male and Female.

Age Range The age in years of the child as of the time he/she was admitted
into foster care. There is no hierarchy for this dimension. Values
include the following:

e 0-2
e 3-5
e 6-9
e 10-13
o 14-17
° 18+
Goal Describes the permanency-planning goal assigned to the child.
There is no hierarchy for this dimension. Values include the
following:
¢ Discharge to Parent/Legal Guardian
o Discharge to Independent Living
e Discharge to Adoption
o Discharge to Adult Residential Care
e Other Goal
¢ No Goal
Admission History Describes the child’s previous admissions history, if any. There

is no hierarchy for this dimension. Values include the following:

Not Previously in Care

Readmitted within 3 months
Readmitted within 4 — 12 months
Readmitted within 13 — 24 months
Readmitted within 25 or more months

CCRS Data As Of Date Indicates the latest date on which the CCRS Data included in
the cube was updated. There will only be one date in this
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dimension.

The measures included in these cubes are as follows:

o Total Admissions — count of the total number of children with an ‘M910’ activity code within
the time period specified.
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Appendix A4:
Discharge from Foster Care Summary Cube

The Discharge from Foster Care Summary Cube provide detailed information on the total number of
children who have been discharged from foster care within a specified time period.

The dimensions included in the Discharge Summary Cube are as follows:

Statewide Geographical location of the child discharged from foster care.
The hierarchy of this dimension is as follows:

Upstate/New York City
S Counties

Date Date on which the most recent discharge occurred. The
hierarchy of the date dimension is as follows:

e Year (1995 - 2001)
Quarters
Months

e  Current Month

e Last Month

e QTD (Quarter to Date)

e Prior QTD (Prior Quarter to Date)

e QTD Grouped (Quarter to Date Grouped — prior
quarter compared to current quarter)

e YTD (Year to Date)
e  Prior YTD (Prior Year to Date)

e YTD Grouped (Year to Date Grouped — prior year
compared to current year)

Agency Where Placed Code plus the name of the agency with which the child was
placed. There is no hierarchy for this dimension.

Facility Type Describes the facility setting. There is no hierarchy for this
dimension. Facility types include the following:

Foster Boarding Home

Approved Relative Home

Institution

Group Residence

Group Home

Supervised Independent Living Program
Agency Operated Boarding Home
Other

Race Describes the racial origin of the child. There is no hierarchy for
this dimension. Races include the following:

e White
e African-American
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e Asian

e American Indian or Alaskan Native
e Other

e Unknown

Hispanic Origin Indicates whether or not the child is of Hispanic origin. There is
no hierarchy for this dimension. Values include Yes and No.

Gender Describes the gender of the child. There is no hierarchy for this
dimension. Values include Male and Female.

Age Range The age in years of the child as of the time he/she was
discharged from foster care. There is no hierarchy for this
dimension. Values include the following:

e 0-2
e 3-5
e 6-9
e 10-13
o 14-17
. 18+
Goal Describes the permanency-planning goal assigned to the child.
There is no hierarchy for this dimension. Values include the
following:
¢ Discharge to Parent/Legal Guardian
o Discharge to Independent Living
e Discharge to Adoption
o Discharge to Adult Residential Care
e Other Goal
¢ No Goal
Discharge Type Describes how the child was discharged, according to the CCRS

system. There is no hierarchy for this dimension. Values include
‘With Continuing Services’ and ‘With Track Closed.’

Final Discharge Reason Describes the reason the child was discharged from foster care.
There is no hierarchy for this dimension. Values include the
following:

e Return to Parent

o Released to Relative

o Release to Own Responsibility
e Adoption

e Order of Court

e Other

CCRS Data As Of Date The date on which the OCFS data warehouse was last updated
with data from the CCRS system. There is only one date in this

dimension.

Direct/Voluntary Indicator Indicates whether the agency is a District/Direct (D) or Voluntary
[ Agency (V).

e Direct

Page 88 OCFS Data Warehouse Reporting
Rev 11/10/2003 Step-by-Step Guide: PowerPlay



e Voluntary

e Unknown

The measures included in these cubes are as follows:

¢ Total Discharges — count of the total number of children who have been discharged from
foster care for a specified period of time.

¢ Average Time in Care at Discharge — average number of months during which a child was
in foster care at the time he/she was discharged.
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Appendix A5:
In Care Summary Cube

The In Care Summary Cube provides summary information on the total number of children whose status
in the CCRS system is 04 (“In 24-Hour Care”) or 06 (“Absent”) for a specified period of time.

Dimensions included in the In Care Summary Cube are as follows:

Statewide Geographical location of the child discharged from foster care.
The hierarchy of this dimension is as follows:

Upstate/Downstate
b Region
S County
L Office
SUnit
S Worker

Date Based on the case initiation date. The hierarchy of the date
dimension is as follows:

Year (1995 - 2001)
S Quarters
SMonths

Agency Where Placed Code plus the name of the agency with which the child was
placed. There is no hierarchy for this dimension.

In Care Status Based on the CCRS status code. There is no hierarchy for this
dimension. Values include ‘In 24-Hour Care’ and ‘Absent.’

Facility Type Describes the facility setting. There is no hierarchy for this
dimension. Facility types include the following:

e Foster Boarding Home

e Approved Relative Home

e Institution

e Group Residence

e Group Home

e Supervised Independent Living Program

e Agency Operated Boarding Home

e Other
Race Describes the racial origin of the child. There is no hierarchy for

this dimension. Races include the following:

o White

o African-American

e Asian

e American Indian or Alaskan Native

e Other

e Unknown
Hispanic Origin Indicates whether or not the child is of Hispanic origin. There is

no hierarchy for this dimension. Values include Yes and No.
Gender Describes the gender of the child. There is no hierarchy for this
Page 90 OCFS Data Warehouse Reporting

Rev 11/10/2003 Step-by-Step Guide: PowerPlay



dimension. Values include Male and Female.

Age Range The age in years of the child as of the time he/she was
discharged from foster care. There is no hierarchy for this
dimension. Values include the following:

0-2
3-5
6-9
10-13
14 - 17
18+

Goal Describes the permanency-planning goal assigned to the child.
There is no hierarchy for this dimension. Values include the
following:

Discharge to Parent/Legal Guardian
Discharge to Independent Living
Discharge to Adoption

Discharge to Adult Residential Care
Other Goal

No Goal

Direct/Voluntary Indicator Indicates whether the agency is a District/Direct (D) or Voluntary

[FOR OCFS: NEED A Agency (V).
DEFINITION] )

e Direct

e Voluntary

e Unknown

ASFA Time in Care Length of time a child was in care based on ASFA guidelines.
There is no hierarchy for this dimension. Values include
‘Children in care at least 12 of 22 months’ and ‘Children in care
less than 12 of 22 months.’

CCRS Data As Of Date The date on which the OCFS data warehouse was last updated
with data from the CCRS system. There is only one date in this
dimension.

The measures included in these cubes are as follows:
¢ Total Children — count of the total number of children in care for a specified period of time.

o Time in Care (average months) — average number of months during which a child was in
care at the time he/she was discharged.
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Appendix B:
Predefined PowerPlay Reports

Appendix B1:

Allegations Report

Report Title: CPS Allegations by Type

Report Purpose: To provide detailed information on substantiated, unsubstantiated, and

undetermined allegations for the period of time requested. Undetermined
allegations include any CPS Reports that were open as of midnight on the last
day of the period covered. An allegation consists of a subject, a child and an
allegation type. Thus, any one investigation may have many allegations. For
example, an allegation of inadequate guardianship of three children on the part of
the mother and father would result in 6 allegations of inadequate guardianship.

Totals: Number of children involved in allegations is totaled as follows:
e Gender and race of the child

e Substantiated/Unsubstantiated/Undetermined status and allegation type
o Statewide — Statewide, region, county

Layers: Statewide— Upstate/Downstate, Region, County, Unit, Worker, Case Name
Other Dimensions
Available: Date

NCANDS Reporter Type
Age Range at Intake
Sex

Race

Connections Data as of

Other Measures:
Available: Allegation Count (total number of allegations)
Data:

Data ltem Data Definition Sample Values
Date of this Current Date 9/30/2001
Report
Data As Of Date of Latest OCFS Data Warehouse Update 9/27/2001
Statewide Geographical location where the allegations Upstate

occurred

Gender Gender of the child involved in the allegation Male, Female, Unknown
Substantiated/ Indicates whether or not credible evidence exists to | Substantiated,
Unsubstantiated/ | substantiate the report of child abuse/maltreatment | unsubstantiated,
Undetermined undetermined
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Data Item Data Definition

Allegation Type Broad groupings of allegations in accordance with
national rather than New York State guidelines

Sample Values
Medical neglect, neglect or
deprivation of necessities,
other, physical abuse,
psychological or emotional
maltreatment, sexual abuse
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Appendix B2:

Investigation Reports—
CPS Stages and Reports Current Status Statewide

Report Title:
Report Purpose:

Totals:

Layers:

Other Dimensions

Available:

Other Measures
Available:

Data:

Data Iltem

CPS Stages and Reports Current Status

To provide CPS supervisors and managers with information about the current
workloads of the staff that they manage. Note: This report runs against the

current year cube only.

Number of CPS Reports that were processed during the period covered by
location of primary worker. Statewide Total reports include totals by Upstate,
New York City, Other Agencies, Statewide Agencies, and Regional Offices.

Location — Statewide, Region, County, Unit, Worker, and CPS Report

Date, NCANDS Reporter Type

See Data Items below.

Data Definition

Sample Values

Date of this | Current Date 9/30/2001
Report

Connections Date of Latest OCFS Data Warehouse Update 9/27/2001
Data As Of

Statewide Geographical location where the allegations Upstate

occurred

Intakes Currently
Not Progressed

The total of all Intakes (INT) that were open as of
the period end date.

Intakes Currently
Not Progressed
— Avg. Days

Average number of days between the period end
date and the Intake Start Date. Calculation =
(Period End Date — Intake Start Date)/Number of
Intakes Currently Not Progressed

Investigative
Stages Currently
Active

Total number of CPS Reports where the
investigation is currently open.

Investigative

Average number of days the investigation has

Stages Currently | remained open.

Active — Avg.

Days
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Data Item
Complete, Not
Currently
Submitted for
Approval

Data Definition
Total number of CPS Reports where all casework
on Connections has been done, but either the
worker has not yet submitted it for approval or the
supervisor has either rejected it or added a second
approver who has not yet approved the CPS
Report.

Sample Values

Complete, Not
Currently
Submitted for
Approval — Avg.
Days

Average number of days between the period end
date and the Intake Start Date for Complete, Not
Currently Submitted for Approval CPS Reports.
Calculation = (Period End Date — Intake Start
Date)/Number of Complete, Not Currently
Submitted for Approval CPS Reports

Submitted for
Approval, Not

Total CPS Reports that have been submitted for
approval but not yet approved by the supervisor.

Approved

CPS Reports Overdue calculations are made as of the last day of

Currently the period covered for CPS Reports that were still

Overdue open on that day. If the report is more than 60 days
old, it is considered overdue. The sum of this
column plus ‘Open CPS Reports Not Currently
Overdue” should equal “CPS Reports Currently
Active”.

CPS Reports Average number of days between the period end

Currently date and the Intake Start Date for overdue CPS

Overdue — Avg.
Days

Reports. Calculation = (Period End Date — Intake
Start Date)/Number of CPS Reports Currently
Overdue

Open CPS Total CPS Reports open as of the last day of the
Reports Not period covered that are less than 60 days old.
Currently

Overdue

Open CPS Average numbers of days between the period end
Reports Not date and the Intake Start Date for Open CPS
Currently Reports Not Currently Overdue. Calculation =

Overdue — Avg.
Days

(Period End Date — Intake Start Date)/Number of
Open CPS Reports Not Currently Overdue
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Appendix B3:

Investigation Reports—
CPS Report Determinations During the Period Statewide Totals

Report Title:

Report Purpose:

CPS Report Determinations During the Period

To provide CPS supervisors and managers with information about the
determinations made on CPS reports by the staff that they manage for the period
requested.

Totals: Number of CPS Reports for which determinations were made during the period
covered by location, based on the primary worker. Statewide Total reports
include totals by Upstate, New York City, Other Agencies, Statewide Agencies,
and Regional Offices.

Layers: Statewide — Upstate/Downstate, Region, County, Unit, Worker, CPS Report

Other Dimensions

Available: Date, NCANDS Reporter Type

Other Measures

Available: See Data Items below.

Data:

Data Item Data Definition Sample Values

Date of this Current Date 9/30/2001

Report

Connections Date of Latest OCFS Data Warehouse Update 9/27/2001

Data As Of

Statewide Geographical location where the allegations Upstate

occurred

Total CPS Total of Initial and Subsequent reports with a

Reports determination of Indicated that were approved by

Indicated the supervisor during the period.

Total CPS Total of Initial and Subsequent reports with a

Reports determination of Unfounded that were approved by

Unfounded the supervisor during the period.

Initial CPS Total of all Initial reports with a determination of

Reports Indicated that were approved by the supervisor

Indicated during the period.

Initial CPS Total of all Initial reports with a determination of

Reports Unfounded that were approved by the supervisor

Unfounded during the period.

(Table continued on next page)
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Data Item

Data Definition

(Table continued from previous page)

Sample Values

Subsequent CPS | Total of all Subsequent reports with a determination
Reports of Indicated that were approved by the supervisor
Indicated during the period.

Subsequent CPS | Total of all Subsequent reports with a determination
Reports of Unfounded that were approved by the supervisor
Unfounded during the period.

Family Indicated

CPS Reports coded CPS, both Initial and
Subsequent, with subjects coded as “Family
Members,” with a determination of Indicated that
were approved by the supervisor during the period.

Family CPS Reports coded CPF, both initial and

Unfounded Subsequent, with subjects coded as “Family
Members,” with a determination of Unfounded that
were approved by the supervisor during the period.

Day Care CPS Reports coded CPD, both Initial and

Indicated Subsequent, with subjects coded “Day Care
Facility/Provider,” with a determination of Indicated
that were approved by the supervisor during the
period.

Day Care CPS Reports coded CPD, both Initial and

Unfounded Subsequent, with subjects coded “Day Care

Facility/Provider,” with a determination of
Unfounded that were approved by the supervisor
during the period.

Foster Care
Indicated

CPS Reports coded CPD, both Initial and
Subsequent, with subjects coded “Foster Parent,”
with a determination of Indicated that were
approved by the supervisor during the period.

Foster Care

CPS Reports coded CPD, both Initial and

Unfounded Subsequent, with subjects coded “Foster Parent,”
with a determination of Unfounded that were
approved by the supervisor during the period.

Other DC/FC Total number of CPS Reports Unfounded, coded

Unfounded CPD, where the subject was other than a foster

parent or day care provider.
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Appendix B4:

Investigation Reports—
CPS Reports Processed During the Period Statewide Totals

Report Title:
Report Purpose:

Totals:

Layers:

Other Dimensions

Available:

Other Measures

CPS Reports Processed During the Period

To provide CPS supervisors and managers with information on the status of
Intakes and Investigations that comprise the workloads of the staff and units that

they supervise.

Number of CPS Reports that were processed during the period covered by
location of primary worker. Statewide Total reports include totals by Upstate,
New York City, Other Agencies, Statewide Agencies, and Regional Offices.

Statewide — Upstate/Downstate, Region, County, Unit, Worker, and CPS Report

Date
NCANDS Reporter Type

Available: See Data Items below.
Data:

Data Item Data Definition Sample Values
Date of this Current Date 9/30/2001
Report
Connections Date of Latest OCFS Data Warehouse Update 9/27/2001
Data As Of
Statewide Geographical location where the allegations Upstate

occurred
Total CPS The total number of CPS Reports that were active
Reports Active at any time during the period covered.
This Period
Total CPS The total number of CPSW Reports active as of
Reports Active midnight on the first day of the period covered.

at Beginning of
Period

Total CPS
Reports Active
at End of Period

The total number of CPS Reports that were active
as of midnight on the last day of the period
covered.

Total New CPS
Reports
Assigned This
Period

The total number of CPS Reports assigned to a
worker during the period requested.

(Table continued on next page)
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Data Item Data Definition Sample Values
(Table continued from previous page)

Total Initial CPS | A subset of Total New CPS Reports Assigned This
Reports Period, reflecting the number of new Initial CPS
Assigned This Reports assigned during the period.

Period

Total A subset of Total New CPS Reports Assigned This
Subsequent CPS | Period reflecting the number of new Subsequent
Reports CPS Reports assigned during the period.
Assigned This

Period

Total CPS The total number of CPS Reports that were still
Reports Overdue | active at the end of the period and the number of
on Last Day of days between the intake start date and the period
Period end date is greater than 60 days.

Total CPS A subset of the Total CPS Reports Closed This
Reports Period that were determined as Indicated.
Indicated

Total CPS A subset of the Total CPS Reports Closed This
Reports Period that were determined as Unfounded.
Unfounded

Total Closed The number of CPS Reports that were closed on
CPS Reports the Connections system but remained opened for
Opened for services.

Services This

Period
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3-D Bar Display

ASCII

Additional Information

Associating

Calculated Column

Calculation

Catalog

Category

CCRS

Clustered Bar Display

Cognos

Appendix C:

OCFS Data Warehouse Reporting

Glossary

A graph that shows relationships between two or more variables. Use to
analyze large quantities of data that are difficult to interpret otherwise.

ASCII stands for American Standard Code for Information Interchange. This is
the code that makes it possible for just about every computer to understand
the letter “A” (and all the other letters) as a letter “A”. The ASCII text file,
although simple and limited, is understood by virtually all computers.

Information that does not constitute a report of abuse/maltreatment but
contains information pertinent to an open/active SCR case.

Linking a data item to a grouped data item to suppress duplicate data values.
There should be a one-to-one relationship between the grouped item and the
item being associated to it.

A column whose values are calculated from other columns, calculated
columns, functions, and constants to derive new data for a model.

A category created by applying an operator to one or more categories. See
also calculated column.

A file that contains all of the information necessary for Impromptu to retrieve
data from a database. The catalog does not contain all of the data, but only a
user view of the database.

Items that match a specific description or classification. Categories can be
different levels of information within a dimension. Any categories can be
grouped into more general categories. For example, a set of dates could be
grouped into a month, and months into quarter, and quarters into years.

Child Care Review Service

A graph that groups related information, compares summaries, and compares
categories.

Cognos is a software development company based in Canada. It is widely
acknowledged to be the leading provider of business intelligence applications.
Business intelligence is the term given to a category of applications and
technologies for gathering, storing, sharing, analyzing, reporting and providing
access to data to help users make better decisions.
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Cognos Common Logon

Column

Connections

Correlation Display

Crosstab Display

Cubes

Data Mart

Data Warehouse

Delimited-Field Text File

Dimension

Dimension Line

Dimension Menu

Dimension Viewer

Cognos Common Logon maintains authentication data so you can open
multiple secure data sources using different Cognos products. This means that
you only have to provide a user ID and password once, even when you
navigate from one Cognos application to another.

In reports, a category that shows related information in a vertical list.
New York State’s child welfare information system.

A graph that shows the value of two measures that are being compared. Bars
represent one measure and a line represents the other. You must have at least
two measures to use a correlation display.

A chart that shows data in tabular format.

A multidimensional representation of data. Cubes contain information
organized into dimensions to provide faster retrieval and drill down to lower-
level categories in reports.

Data marts are subsets of the larger data warehouse. They are smaller and
focused on a particular subject.

A data warehouse is a collection of data retrieved from production systems.
The data from diverse databases is combined and stored separately. The data
warehouse organizes and stores the data needed for informational and
analytical processing over a historical time perspective.

A file containing text data, where the fields in each record are separated
(delimited) by a character, such as a comma or a tab.

A broad grouping of descriptive data about a major aspect of an organization,
such as dates, geography, ethnicity, etc. Each dimension includes different
levels of categories in one or more drill-down paths, and an optional set of
special categories.

In PowerPlay for Windows, shows the categories from each dimension used to
filter on data for the current report.

In PowerPlay for Windows, a menu that appears when you select a dimension
folder. You use a dimension menu to filter on specific information. When you
select a category from the menu, the level of the dimension changes and so do
the values in the report.

An organized view of all dimensions, levels and categories in the selected
cube. Use the dimension viewer to add categories as rows, columns, or layers,
create subset definitions, format measures, filter, and define sets of categories.
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Display

Drill

Drill Down/Up

Drill-Through

Filter

Fixed-Field Text File

Functions

Grouping

Horizontal Axis

In PowerPlay for Windows, the type of chart or graph. You can change the
display or add another display to the same report.

See Drill Down/Up or Drill-Through

Focusing a report on a lower level of detail in a particular dimension; i.e.,
looking at child categories.

Accessing more detailed information in another PowerPlay report, PowerCube,
or Impromptu report. Drill-through access is set up to match on some
combination of dimensions, measures, or data items.

Focus a report on a specific value of a data item or dimension.

A file that contains text data aligned in fixed-length columns.

A predefined formula that takes one or more values, performs an operation,
and returns a value.

Grouping data in an Impromptu serves to bring all like data together on the
report.

The X-axis on a display.

Impromptu Impromptu is a user-friendly data query tool that allows the user easy access
to a database while shielding him/her from technical database terminology,
connections, and structures.

IAB Institutional Abuse cases which are investigated by IAB investigative agencies
(Regional Offices, Office of Mental Health, Office of Mental Retardation
(OMR), or Developmental Delays (OMRDD).

Indicated A determination made by local CPS that some credible evidence exists to
support an incident of child abuse and/or maltreatment.

Initial Report Information that contains a reasonable cause to suspect child abuse and/or
maltreatment that has no open or active case in the SCR.

Join Defines the relational links between tables in a database so that you can
retrieve information from more than one table at a time.

Key Fields The data items used to join tables.

Label The name of a row, column, or layer.
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Layers

MDC File

Measures

Missing Value

Multidimensional Cube File
(-mdc)

Multiline Display

NCANDS

Nesting

OCFS

PDF

Pie Display

PowerPlay

Prompts

Another dimension, in addition to rows and columns, added to a report.
Reports can contain several layers, but you can look at only one at a time.

A Cognos file that represents a cube. The file may contain the data, or be a
pointer file to a database cube or third-party OLAP source.

Numeric data used as performance indicators. For example, measures can be
number of allegations, number of CPS Reports Indicated, number of children
admitted to foster care, etc.

A value that is not available for a category because of the context, or because
there is no data. Missing values appear in a report as zero, NA (not available),
a blank (nothing in the cell), or missing, depending on how the measure sin the
cube were designed to handle missing values.

See cube or .mdc file.

A graph that reveals and compares trends and cycles that show relationships
between variables. It also shows time series analysis and relationships
between variables.

National Child Abuse and Neglect Data System.

Adding another dimension or dimension level to an existing row or column on a
report to provide a more detailed perspective of the data.

Office of Children and Family Services

Portable Document Format. A file format developed by Adobe Systems that
captures formatting information from a variety of desktop publishing
applications, making it possible to send formatted documents and have them
appear on the recipient’s monitor or printer as they were intended. To view a
file in PDF format, you need Adobe Acrobat Reader.

A graph that shows the relationship between the whole and the parts. For
example, a pie display can show how much of a department’s budget goes to
paper supplies.

PowerPlay is a data analysis tool that utilizes OLAP (On Line Analytical
Processing) technology. It allows users to easily explore data across the
organization.

Request for information when a report is opened that determines the focus or
scope of the report.
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Query

Ranking

Row

Scatter Display

Simple Bar Display

Single Line Display

Slice and Dice

Sort

Stacked Bar Display

Subsequent Report

A question to a database that defines what information you want from the data
source.

Assigning ordinals to values in a selected row or column of a report, to be used
to sort the values in ascending or descending order.

A category that shows related information in a horizontal list.

A graph that compares two different measures. You must have at least two
measures to use the scatter display effectively.

A graph that shows change over a specific time period, contrasts two or more
variables, and reveals trends and irregularities in a bar format.

A graph that shows change over a specific time period, contrasts two or more
variables, and reveals trends and irregularities in a line format.

To change and arrange data when you:

. Choose different categories for your
report

. Drill down or drill up

. Drag dimensions from the dimension line

. Swap rows, columns, or layers

. Filter information

For example, you have a report that shows the number of CPS Reports by
each district at the end of the last quarter. You can slice and dice information
to show CPS Report Determinations over the last two months for each worker.

To arrange values in numerical order, or labels in alphabetical order. You can
sort in ascending or descending order.

A graph or chart that shows relative proportions of parts to the whole and the
relationship between the parts. For example, the days to determination data
can be segmented into indicated and unfounded determinations as stacked
bars.

A report involving either new allegations or a new incident of the same
allegations occurring under an open SCR case number.

Substantiated A finding by local CPS that credible evidence exists to support an allegation of
child abuse and/or maltreatment.
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Swapping

Unfounded

Unsubstantiated

Variable

Vertical Axis

View

To exchange the position of categories in a report. You can swap rows and
columns, columns and layers, or rows and layers. The terms rows and
columns change depending on the current display. For a pie display, rows and
columns are called displays and slices.

A determination made by local CPS that no credible evidence has been found
to substantiate the report of child abuse and/or maltreatment.

A finding by local CPS that no credible evidence exists to support an allegation
of child abuse and/or maltreatment.

A symbol representing a value supplied by your computer or by PowerPlay for
Windows. For example, the variable Date represents today’s date. You can
add a report variable such as Date to a report title, header, or footer.

The Y-axis on a display.

In PowerPlay for Windows, a way of presenting a report: normal, page layout,
and page width. You can use a combination of views. For example, you can
use normal view for working with the report, and page layout view or page
width view to organize parts of the report. There are two types of views:
dimension views and user class views. See also Display.
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